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THE ENERGY CONSERVATORY, INC.  SOFTWARE PRODUCT LICENSE AGREEMENT 

(appears during software installation) 
 
This legal document is an agreement between the end user (hereinafter “Licensee”) and The Energy Conservatory, Inc. 

(hereinafter "TEC").  This agreement constitutes the complete agreement between the licensee and TEC for this software 

program, which includes computer software and may include associated media, printed materials and electronic 

documentation (hereinafter “Software Product”) . 

 

BY SELECTING THE YES BUTTON BELOW, YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, 

YOU UNDERSTAND IT AND YOU AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS, WHICH INCLUDE 

THE SOFTWARE PRODUCT LICENSE, THE EXPRESS LIMITED WARRANTY AND THE LIMITATION OF 

WARRANTY AND LIABILITY (Collectively the "Agreement").  THIS AGREEMENT APPLIES TO YOU AND ANY 

SUBSEQUENT LICENSEE OF THIS SOFTWARE PRODUCT. 

 

IF YOU DO NOT ACCEPT OR AGREE TO THE TERMS OF THIS AGREEMENT, PRESS THE NO BUTTON BELOW. 

 

1.  THE ENERGY CONSERVATORY, INC. SOFTWARE PRODUCT LICENSE 

 

A.  GRANT OF LICENSE.  TEC grants to licensee a non-exclusive right to use this copy of the Software Product on a single 

computer at a single location.  This Software Product is licensed, not sold, to you by TEC and may be used, in object code 

form only and only in conjunction with testing hardware and software programs authorized by TEC. You agree not to 

translate, reverse engineer, reverse compile, disassemble or make derivative works from this Software Product.  You may 

neither sublicense the Software Product, nor sublicense or assign the license granted under this agreement, without prior 

written authorization from TEC.  TEC reserves all rights not expressly granted to licensee. 

 

B.  OWNERSHIP OF SOFTWARE.   TEC retains title and ownership of the Software Product.  This license is not a sale of 

the original Software Product or any copy thereof. 

 

C.  COPY RESTRICTIONS.   The Software Product and any accompanying documentation are copyrighted.  Unauthorized 

copying of the Software Product, including software that has been modified, merged, or included with other software, or of 

any accompanying documentation is expressly forbidden. 

 

2.   EXPRESS LIMITED WARRANTY  

 

TEC warrants that the Software Product will perform substantially in accordance with the accompanying written materials for 

a period of 90 days from the date of receipt by the licensee. 

 

3. LIMITATION OF WARRANTY AND LIABILITY 

 

The foregoing warranty is in lieu of all other warranties and is subject to the conditions and limitations stated herein.  TEC 

MAKES NO WARRANTY OR REPRESENTATION, EITHER EXPRESSED OR IMPLIED, WITH RESPECT TO THIS 

SOFTWARE PRODUCT, INCLUDING ITS QUALITY, RESULTS OBTAINED, PERFORMANCE, 

MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 

 

THE EXCLUSIVE REMEDY OF THE PURCHASER FOR ANY BREACH OF WARRANTY shall be the return of the 

Software Product to TEC for replacement, or, at the option of TEC, refund of the purchase price.   

 

IN NO EVENT WILL TEC OR ITS DISTRIBUTORS OR AGENTS BE LIABLE FOR INDIRECT, SPECIAL, 

INCIDENTAL, OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR THE INABILITY TO USE THE 

SOFTWARE PRODUCT, even if advised of the possibility of such damages.  In particular, TEC is not responsible for any 

costs including, but not limited to, those incurred as a result of lost profits or revenue, loss of the use of the software, loss of 

data, the cost of recovering such software or data, the cost of substitute software, or the claims of third parties.  In any case, 

TEC’s maximum liability for any and all losses, injuries or damages (regardless of whether such claims are based on contract, 

negligence, strict liability or other tort) shall be the purchase price paid for the Software Product. 

 

This limitation of Warranty and Liability may not be amended or modified, nor may any of its terms be waived except by a 

writing signed by an authorized representative of TEC.
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Chapter 1    Introduction to TECTITE 

   
 
TECTITE (Ver. 4.0 - WiFi) is an automated building airtightness testing program for PC’s.  The TECTITE 

program can be used with the Model 3 or Model 4 Minneapolis Blower Door or the Series B Duct 

Blaster fans to conduct fully automated Blower Door airtightness tests.  During a Blower Door test, the 
program controls the speed of the Blower Door fan, prompts for installation or removal of flow rings, 
records both building pressure and fan airflow, and calculates and stores test results.  TECTITE can also be 
used to analyze manually collected Blower Door test data. 
 

 

1.1  TECTITE Features 
 

• Computerized control of Minneapolis Blower Door fans using either a DG-700 or DG-1000 Digital 
Pressure Gauge, or an APT system.  

• Choice of four pre-set test protocols (CGSB 149.10-M86, RESNET One-Point Test, RESNET Multi-
Point Test, and the RESNET Repeated Single-Point Test) and custom test options.  

• Compatible with wireless communication from the DG-1000 Gauge, and from the TEC WiFi Link 
adapter (DG-700) to wirelessly connect your gauge to your computer and TECTITE. 

• Calculation and display of airtightness test results, including deviation from standards listings. 

• Measurement and display of multiple building zone pressures during a CGSB Blower Door test 
(requires additional DG-700, or APT system with 3 or more pressure channels). 

• Automated operation and on-screen instructions reduce operator error, eliminates time spent zeroing 
gauges and adjusting fan speed, and ensures that tests are conducted the same way every time.    

• Multiple simultaneous pressure measurements of building pressure and fan air flow reduce the 
variability of test results from wind.  

• Cruise control for maintaining a constant building pressure during diagnostic tests or airsealing.  

• Calculates need for mechanical ventilation based on estimated annual natural infiltration rates and 
ASHRAE 62.2-10 whole building ventilation guideline. 

• Estimated design infiltration rates can be used in Manual J load calculations. 

• Choice of report formats including a simple easy-to-read homeowner report, or a detailed technical 
report, plus a built-in PDF file report generator. 

• Manual mode for analyzing and displaying manually collected test data. 
 
During automated testing, TECTITE adjusts the speed of the Blower Door fan while simultaneously 
monitoring the building pressure and fan air flow using 2 differential pressure channels built into either the 
DG-700 or DG-1000 gauge, or the APT’s Data Acquisition Box (DAB).  One pressure channel is used to 
measure building pressure while the other pressure channel is used to measure Blower Door fan air flow. 
Wired communications between the DG-700, DG-1000 or DAB and your computer is provided through 
either a USB, Ethernet or RS-232 serial communication link. In addition, TECTITE can connect wirelessly 
with a DG-1000 gauge and the TEC WiFi Link adapter (DG-700) to provide a communication link through 
your computer. 
 
 

1.2  Auto Versus Manual Operation 
 

The TECTITE program can be run using three different operating methods: 
 

• The program can be used to fully automate a Blower Door airtightness test using the DG-700 or DG-

1000 gauge, or an APT DAB (Auto Method). The Auto Method provides automated collection of 
building pressure and fan flow data, and computerized control of the Blower Door fan. 

• The Semi-Auto Method provides automated collection of the building pressure and fan flow data, but 
the Blower Door fan is controlled manually. 

• The program can also be used to enter and analyze manually collected Blower Door test data (Manual 

Method). 
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The three different operating methods are selected from the Test Settings screen (using the Method field).   
The Test Settings screen is discussed in more detail later in Chapter 6.  Much of the operation of the 
TECTITE program is the same for the Manual, Semi-Auto and Auto Methods. 

 

 

1.3  Help Buttons 

 
Each screen in the TECTITE program contains a Help button to provide you with detailed information for 
that screen.  Wherever you see the Help button, clicking on it will open a text window.  We recommend that 
you use all the Help buttons the first time you run the program.   
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Chapter 2    Setting Up the Hardware for Automated Testing 

 
 

Note:  If you will not be conducting Automated or Semi-Automated Blower Door tests, skip to Chapter 3. 
 

2.1  Hardware Set Up Using a DG-700 

 

1. Install the Blower Door system as described in the Blower Door operation manual. 
 

2. There are three options for connecting your DG-700 gauge to your computer to create the 2-way 
communication link needed for automated testing with TECTITE:  

 
– Connect the mini-USB port on the DG-700 gauge to a standard USB port on your computer 

(Note: some older DG-700 gauges do not contain a mini-USB port). 
– Install a TEC WiFi Link adapter onto the DB-9 serial communication port on the DG-700 

gauge and wirelessly connect to your computer. 
– Connect the DB-9 serial communication port on the DG-700 directly to a DB-9 port on your 

computer. 
 

 

Using the mini-USB Port 

 
In order to use the mini-USB communication port on your DG-700 gauge, you will need a USB cable 
(A to mini B), and you will need to install the necessary USB drivers onto your computer. The DG-
700 USB driver is available from The Energy Conservatory’s website 
(www.energyconservatory.com), or from the Windows Update service. 

 

Using the TEC WiFi Adapter (Direct Connect AP Mode) 
 
Insert the male DB-9 connecter on the TEC WiFi Link into the female DB-9 
connector on the DG-700 gauge. Tighten the two attachment screws on the 
TEC WiFi Link.  Attach the Power Jumper Cable between the TEC WiFi Link 
and DG-700.  Install the power jumper cable into the power input jacks on the 
TEC WiFi Link and DG-700 gauge.  The jumper cable allows the gauge to 
provide power to the TEC WiFi Link. Light #1 (blue) on the TEC WiFi Link 
will turn on indicating that it is receiving power. 
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Turn on the DG-700. Once the ON/OFF button is pressed light #2 (green) on the TEC WiFi Link will 
begin to blink. Light #2 will then turn on solid indicating that it is broadcasting a wireless network 
access point.  The display on the DG-700 should be dashed to indicate that it is ready to be controlled 
remotely (the keypad is not functional when the display is dashed).  
 
On your computer select and connect to the TEC WiFi Link wireless network.  The network will be 
named “DG700-<SN>” (where SN is the serial number of the DG-700 gauge). The first 
time you connect to this network, you may be asked for a password/security key - enter 

the default password/security key   tecwifi12     TECTITE should now be able to detect 
the gauge and create a communication link. 
 

Note: The method used to connect to the wireless network will depend on the model and 
operating system of your computer. If your computer is currently connected to another 
wireless network, you may need to disconnect from that network before connecting to the 
TEC WiFi Link network. The DG-700 gauge must be on in order for the TEC WiFi Link 
network to be visible from your computer.  

 

Using the DB-9 Serial Port 

 
If you will be using the DB-9 Serial Communication Port on the DG-700 gauge, simply plug the male 
end of a standard 9-pin serial cable into the serial port on the top of the DG-700, and the female end 
should be plugged into an open serial communication port on your computer.   
 

 
3. In order for TECTITE to control the speed of the Blower Door fan, you will need to connect the DG-

700 to the Blower Door fan speed controller using the fan control cable. One end of the fan control 
cable should be plugged into the 3.5 mm fan control output jack on the top of the DG-700, and the 

other end of the cable should be plugged into the side of the fan speed controller case.  Note:  If you 
will be conducting a Semi-Auto test and manually controlling the Blower Door fan, you will not need 
to install the fan control cable. 

 

Communication Jack 

(Blower Door Speed 

Controller) 
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4. Connect tubing between the DG-700 and the Blower Door system (tubing connections are detailed in 

the Blower Door operation manual). 

• Channel A Input Tap:  connect to inside of building (leave open if gauge is in the building). 

• Channel A Reference Tap:  connect to outside (typically use green tubing). 

• Channel B Input Tap:  connect to BD fan (typically use red tubing). 

• Channel B Reference Tap:  connect to space upstream of fan inlet (if fan inlet and gauge are in the 
same space, leave the tap open). 

 
 

2.2  Hardware Set Up Using a DG-1000 

 

1. Install the Blower Door system as described in the Blower Door operation manual. 
 

2. There are three options for connecting your DG-1000 gauge to your computer to create the 2-way 
communication link needed for automated testing with TECTITE:  

 
– Connect the micro-USB port on the DG-1000 gauge to a standard USB port on your 

computer.  
– Wirelessly connect to your computer using the gauge’s built-in WiFi adapter. 
– Connect the Ethernet port on the DG-1000 to a router or Ethernet switch, and connect the 

router or switch to your computer.  Note: The router or Ethernet switch must be running 
DHCP server.  

 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

Using the micro-USB Port 

 
In order to use the micro-USB communication port on your DG-1000 gauge, you will need a USB 
cable (A to micro B), and you will need to install the necessary USB drivers onto your computer. To 
enable the micro-USB port on a gauge, go the main DG-1000 Settings screen and select [Network 
Configuration] … [Mode - USB].  The networking status in the Network Configuration screen will 
show “Not Connected”.  Now install one end of an USB cable into the micro-USB port on the DG-
1000 gauge and the other end into a standard USB port on your computer. The Windows Update 
service on your computer will start and try to access the internet and find and install the appropriate 
driver (USB Ethernet/RNDIS Gadget). Once the driver is installed, the network status on the gauge will 
change to “Connected”. TECTITE should now be able to detect the gauge and create a communication 

link. Note: your computer must have an internet connection in order to find and install the driver. 
 

Fan 
Control  
Output 
Jack Ethernet  

Port 
micro-USB 
Port 
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Using the DG-1000’s Built-in Wireless Adapter 

 

WiFi (Create Network) 

 
The DG-1000’s built-in WiFi module can be configured to create and broadcast a wireless network that 
can be connected to directly from a computer. To enable this feature, go to the main DG-1000 Settings 
screen and select [Network Configuration] … [Mode - WiFi (Create Network)]. The networking status 
in the Network Configuration screen will now show “Broadcasting” and the gauge will begin 
broadcasting a secured wireless network. 
 
On your computer select and connect to the DG-1000 wireless network.  The network will be named 
“DG1000-<SN>” (where SN is the serial number of the DG-1000 gauge). The first time you connect to 
this network, you may be asked for a password/security key - enter the default password/security key  

dg1000pw   TECTITE should now be able to detect the gauge and create a communication link.  Note: 

The method used to connect to the wireless network will depend on the model and operating system of 
your computer. If your computer is currently connected to another wireless network, you may need to 
disconnect from that network before connecting to the DG-1000 wireless network.  
 

WiFi (Join Network) 

 

The DG-1000’s built-in WiFi module can also be configured to join an existing wireless network 
(typically created by a router). When set up in this mode, the gauge will search for a specific wireless 
network and automatically join the network. You can then remotely access the gauge using TECTITE if 
your computer is also connected to the same wireless network.  
 
Typically you would bring your own router into the building to use this feature, however, an existing 
building router can be used if you know the network name (SSID) and Password. Using the WiFi (Join 
Network) feature can extend the effective WiFi communication distance between your gauge and your 
computer. 
 
To enable WiFi (Join Network) mode for the gauge, go the main DG-1000 Settings screen and select 
[Network Configuration] … [Mode – WiFi (Join Network)] … [Configuration – SSID - Password]. Fill 
in the SSID and Password fields with the name and password of the wireless network you are 
connecting to. After pressing Apply, the gauge will apply the network settings and begin searching for 
the wireless network and will join it (providing that the SSID and Password match). The networking 
status in the DG-1000 Settings screen will update and show “Joined” and list the SSID of the network if 
a connection has been made.    
 
On your computer, select and connect to the same wireless network. Once this connection is made, 
TECTITE should be able to detect the gauge and create a communication link.  
 

Using the Ethernet Port 
 
The Ethernet port on the DG-1000 can be used to create a network that can be used by your computer 
and TECTITE to create a communication link.  Using the gauge’s Ethernet requires a router or Ethernet 
switch that can manage the network connections (typically done by DHCP Server running on the router 
or switch). You can also use a standard Ethernet switch as long as it is connected to a device running 
DHCP Server. 
 
To enable the Ethernet port on a gauge, go the main DG-1000 Settings screen and select [Network 
Configuration] … [Mode - Ethernet].  The networking status in the Network Configuration screen will 
show “Not Connected”.  Now install one end of an Ethernet cable into the port on the DG-1000 gauge  
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and the other end into an Ethernet port on the router or switch. The Network Configuration status 
should update to show “Connected”.  
 
Now you will need to connect your computer to this same router or switch. This can done by 
connecting the Ethernet port on the computer to the router or switch, or by wirelessly connecting the 
computer to the wireless network being broadcast by the router. Once the computer is connected to the 
network, TECTITE should be able to detect the gauge and create a communication link. Ethernet 
cables can be up to 328 feet long and still provide a robust communication link. 

 
3. In order for TECTITE to control the speed of the Blower Door fan, you will need to connect the DG-

1000 to the Blower Door fan speed controller using the fan control cable. One end of the fan control 
cable should be plugged into the 3.5 mm fan control output jack on the top of the DG-1000, and the 

other end of the cable should be plugged into the side of the fan speed controller case.  Note:  If you 
will be conducting a Semi-Auto test and manually controlling the Blower Door fan, you will not need 
to install the fan control cable. 

 

 
 
4. Connect tubing between the DG-1000 and the Blower Door system (tubing connections are detailed in 

the Blower Door operation manual). 

• Channel A Input Tap:  connect to inside of building (leave open if gauge is in the building). 

• Channel A Reference Tap:  connect to outside (typically use green tubing). 

• Channel B Input Tap:  connect to BD fan (typically use red tubing). 

• Channel B Reference Tap:  connect to space upstream of fan inlet (if fan inlet and gauge are in the 
same space, leave the tap open). 

 
 

2.3  Hardware Set Up Using an APT System 
 

1. Install the Blower Door system as described in the Blower Door operation manual. 
 

2. Connect the APT Data Acquisition Box (DAB) to your computer using a 9 pin serial cable. The male 
end of the cable should be plugged into the COM port on the end of the DAB, and the female end 
should be plugged into an open serial communication port on your computer.   

 

Communications Ports/Switches on the DAB 

 

DC
12V

OFF

ON FAN
COM

Serial  Communication Port 
Fan Control 
Output Jack 

Communication Jack 

(Blower Door Speed 

Controller) 
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Note:  If your computer does not have a serial port, but does have a USB port, you will need to 
purchase an after-market USB to Serial Port adapter (contact TEC for adapter recommendations). 

 

3. Connect the Blower Door fan speed controller to the DAB using the fan control cable provided. The 
phone plug end of the cable is plugged into the Fan Control Output Jack on the end of the DAB while 
the other end of the cable is plugged into the communication jack on the side of the speed controller.  

 
4. Connect tubing between the DAB and the Blower Door system (tubing connections are detailed in the 

Blower Door operation manual).  Note: If you will be measuring building zone pressures during the 
airtightness test using Channels P3 – P8, refer to Chapter 10 for more information on installing tubing 
from the DAB to the zones to be tested. 

 

 
 
 
 
 
 
 

To outside 
(green tubing) 

To inside of building 
(leave open if DAB is 
in the building) 

 

To  BD fan 
(red tubing) 

To space upstream of fan inlet. 
(If fan inlet and DAB are in the 
same space, leave open) 
 

INPUT 

REF 

P1 P2 
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Chapter 3    Setting Up the Building for Testing  

 
 
After installing the Blower Door system, you will need to set up the building in its normal heating or 
cooling mode.  This typically includes closing adjustable openings and preparing combustion appliances.  

Refer to your Blower Door manual for more specific instructions , or refer to set-up guidelines 

specifically referenced in the Test Standard you are using. 
 
 

3.1  Adjustable Openings   

 

• Close all storm and prime windows. 

• Close all exterior doors and attic or crawlspace hatches connected to conditioned spaces.   

• Open all interior doors to rooms that are heated or cooled.  The object here is to treat the entire 
building as one connected space.  Because few basements can be completely sealed from the building 
and usually some conditioning of basement air is desirable, they are typically included as conditioned 
space. 

• Tape plastic over window air conditioners if they appear to be a source of air leakage into the building 
and they are removed during the heating season. 

 
 

3.2  Combustion Appliances/Exhaust Devices 
 

• Adjust all combustion appliances so they do not turn on during the test.  This is commonly done by 

temporarily turning off power to the appliance, or setting the appliance to the “pilot” position.  Note:  If 

vented combustion appliances turn on during a depressurization test, it is possible for flames to be 

sucked out of the combustion air inlet (flame rollout).  This is a fire hazard and can possibly result in 

high CO levels. 

• Be sure that fires in fireplaces and woodstoves are completely out.  Take precautions to prevent ashes 
from being blown into the building during the test.  In most cases closing dampers and doors is 
sufficient, but when they are leaky or absent, it will be necessary to tape fireplace doors shut, clean out 
the ashes, or cover the ashes with newspaper. 

• Turn off all exhaust fans, vented dryers, air conditioners and air handler fans. 
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Chapter 4    Starting the TECTITE Program  

 
 

4.1  Turn on the Gauge or DAB and Fan Speed Controller (Auto Methods Only) 
 

• Turn on the DG-700, DG-1000, or DAB (plug in the DAB’s power supply if necessary).   

• Turn the Blower Door fan speed controller to the “just on” position (the fan should not be turning in 
this position). The speed control knob should be turned all the way down, without being clicked into 

the “off” position.  Note: The speed controller should have already been plugged into the fan and into a 
power source.  

 
 

4.2  Starting TECTITE 
 

To start TECTITE, click on Start...All Programs...Energy Conservatory...TECTITE 4.0. 

 

The main TECTITE screen will now appear, with the Main Menu containing File, Options, Goto and Help 
located in the upper left hand corner. 
 

 Main TECTITE Screen 

TECTITE 4.0 
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Chapter 5    Overview  (Auto, Semi-Auto and Manual Methods) 

 
 

5.1  Starting a New Test 

 

To start using the TECTITE program, open the File Menu by clicking on File in the Main Menu.  The top 
of the File Menu contains three starting options: 

 
 
 
 
 
 

� New Test   is selected to begin a new building airtightness test using the factory default 
program settings.  Both the Test Standard Selection and Equipment Information windows are 
automatically opened so that you can select the appropriate test standard, and the correct fan 
model being used for the test.  After selecting the test standard and fan model, the Building 
Test Information screen will appear.  

� New Test with Custom Configuration   is selected to begin a new building airtightness test 
using custom configuration files which you have previously created and saved.  Using 
configuration files is the most efficient way to run TECTITE.  Creating and saving 
configuration files is discussed in Chapter 14.  After selecting a configuration file to load, the 
Building Test Information screen will appear. 

� Retrieve Existing Test   lets you recall a previously saved building test file.  After selecting 
the building test file to retrieve, the values from the retrieved file are loaded into the program, 
and the Building Test Information screen appears.  Once a file is recalled, it may be viewed, 
edited and re-saved (with the same or a different file name).  Refer to Chapter 11 for more 
information on retrieving and saving files. 

� Compare Tests   lets you recall two previously saved building test files and compare the saved 
test results.  After selecting the two test files to compare, a compare test results screen 
appears.  Refer to Chapter 18 for more information on using the Compare Tests feature. 

 
Menu choices are selected by clicking on the desired option.  We recommend that first time users begin by 

selecting New Test.  The other starting options should be explored after familiarizing yourself with the 
TECTITE program.   
 
 

5.2  Input Screens 

 
The first 4 screens of TECTITE are input screens where you will enter information about the customer, the 
building being tested, local climatic conditions, information related to mechanical ventilation needs, and 
any relevant comments that you would like to save along with the test file.  An overview of the 4 screens are 

shown on the next page.  You can click on individual fields to enter information, or use the Tab key to 

quickly move between fields.  To clear a screen, click on the Clear button at the bottom of each page.  

When you are finished with a screen, click on the Next button to proceed.  At any time, you can step back 

to earlier screens by using the Previous button. 
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Input Screens 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Building Test Information Screen: 

   The Building Test Info screen is  
   used to input information about the  
   customer for whom the airtightness test is  
   being performed, as well as the address and 
   physical dimensions for the building being 
   tested. 

Comments Screen: 

   The Comments screen is used to enter an  
   unlimited number of lines of comments on  
   the building being tested.  Comments are  
   stored with the test file and are printed out  
   along with the test report. 

 

Environmental Information Screen: 

   The Environmental Info screen is used to 
   enter weather and energy cost information 
   needed to calculate various test result 
   variables (e.g. design infiltration rates).   

Mechanical Ventilation Screen: 

   This screen is used to determine if whole- 
   building mechanical ventilation calculations 
   (based on ASHRAE 62.2-2010) will be  
   performed and reported by TECTITE.  In  
   addition, the inputs necessary to calculate the 
   alternate compliance supplement for existing  
   housing can be entered from this screen. 
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5.3  Auto Test Method 
 

After completing the Comments screen, click on Next to move to the Test Settings screen.  (Note: If you 
want to operate using the Manual data entry method, refer to the Section 5.4 below.) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

5.4  Manual Test Method 
 

After completing the Comments screen, click on Next to move to the Test Settings screen: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Test Settings Screen: 
   The Test Settings screen is used to input 
   settings that will be used during the  
   airtightness test.  When conducting automated 

   tests, be sure the Method button is set to  

   Auto (or Semi-Auto if you will be conducting a  

   Semi-Auto test). Click on Next to move to the 
   Test Graph screen.    
 

Test Graph (Auto Method): 
   The automated airtightness test and cruise 
   control features are controlled from this 
   screen.  During an automated test, Blower  
   Door test data are collected by TECTITE  
   at a series of target building pressures 
   which are designated by the vertical blue  
   lines on the graph.  To begin a test, click on  

   the Start Test button. 

Test Settings Screen: 
   To set the program for manual entry of 
   Blower Door test data (i.e. building and 

   fan pressure readings), be sure the Method 

   button is set to Manual.  Click on Next to 
   move the Test Graph screen.   
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5.5  Test Results 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

Test Graph (Manual Method): 
   When using Manual Method, manually 
   entered test data are displayed on this screen. 

   To begin entering data, click on the Data 

   Table button.  

Data Table: 
   The data table is used to input Blower Door 
   test data that were collected manually, rather 
   than collected automatically by TECTITE.  
   The format of the data table will depend on 
   the selected Test Standard.  The data table  
   to the right is for a CGSB test and allows entry 
   of up to 12 sets of Blower Door test readings, 
   plus pre-test and post-test baseline building  
   pressure readings, and temperatures during 
   the test.  After you have entered all data into  

   the table, click on OK to return to the Test  
   Graph.   

Test Results: 
  To look at the calculated test results, click on      

  Next from the Test Graph screen.  Test results    
  are automatically calculated using all data points  
  displayed on the graph, and values entered into   
  the Input screens.  From the Test Results screen,  

  click on Next to see the Deviations from  

  Standard screen.  Note: If you are conducting an  
  Automated (or Semi-Auto) test, and were  
  measuring zone pressures during the Blower  

  Door test, the Next button will first take you to  
  the Zone Data screen, before going the  
  Deviations from Standard screen..   
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5.6  Zone Data (CGSB Test - Auto and Semi Auto Methods Only) 
 

 

 

 

 

 

 

 

 

 

 

 
 

 

5.7  Using the Goto Menu 

 

The Goto item in the Main Menu allows you to quickly move to any active screen within the TECTITE 

program.  Clicking on Goto will bring up the following dialog box.  
 
 
 
 
 
 
 
 
 

 
Simply click on one of the active choices to immediately move to that screen.  If no test data have been 
taken (or manually entered), the Test Results, Zone Data and the Deviations from Standard screens will not 
be available.  
 
 
 
 

Zone Data: 
  To look at the measured zone data, click on      

  Next from the Test Results screen.   
 
  
 
 
 
 
 

Deviations from Standard: 
  This screen lists aspects of the current test data 
   that deviate from the selected Test Standard. 
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Chapter 6    Editing the Input and Test Settings Screens 

 
 

6.1  Building Test Information Screen 

 
The Building Test Information screen is used to input both customer and building specific information.  To 

enter information, click on individual fields, or use the Tab key to quickly move between fields.  To clear 

the screen, click on the Clear button.  When you are finished entering the information, click on Next to 
move to the Environmental Information screen. 
 
The first three fields on this screen are used to enter the date of the test, the name of the technician 
performing the test, and an optional project number.  The Customer Information section contains fields to 
input the name, address and contact information of the customer for whom the airtightness test is being 
conducted.   
 
The Building Information section is used to input the address and physical measurements for the building 
being tested.  If any of the fields in the Building Information section are left blank, the test can still be 
completed, however test results requiring those inputs will not be calculated or displayed on the Test 
Results screen.  
 
All information entered on this screen is stored as part of the test file. 
 

Building Test Information Screen 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Volume:  Enter the volume of the building’s intentionally heated or cooled spaces.  If you are testing a 
building with a basement, we recommend that you include the basement if it is to be kept closer to inside 
temperature than outside temperature.  (If you include the basement in your volume calculation, perform the 
Blower Door test with any doors between the basement and the building kept open.). 
 
If you enter a value of 0 (or leave the field blank), Air Changes per Hour at 50 Pascals will not be 
calculated or printed. 
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Floor Area:  Enter the floor area of the building.  This value typically includes all floors in intentionally 
heated or cooled spaces.  If you have included the basement in your volume calculation, also include the 
basement in the floor area calculation.   
 
If you enter a value of  0 (or leave the field blank), this variable will not be calculated. 

 
Surface Area:  Enter the surface area of the exterior envelope of the building.  This value typically 
includes all walls, floors and ceilings bordering the volume being tested.  You may define surface area using 
your own convention, or it may be defined by the test protocol you are using.  
 
If you enter a value of  0 (or leave the field blank), this variable will not be calculated. 

 
Height:  Enter the average above grade building height.  This average should include the above grade part 
of a basement if it is included in the volume calculation.  Do not include an attic space unless the attic is 
conditioned space and is included in the volume calculation. 
 
If you enter a value of  0 (or leave the field blank), all variables requiring this field will not be calculated. 

 
# of Bedrooms:  Enter the number of bedrooms for the building being tested.  This number is used to 
determine ventilation requirements.  The occupancy of the building is assumed to be the number of 
bedrooms plus one, or the number of occupants (see below), whichever is larger. 

 
# of Occupants:  Enter the number of occupants that are living in the building.  When determining the 
occupancy of a building, the program uses either the # of occupants, or the # of bedrooms plus one, 
whichever is greater. 
 
 

6.2  Environmental Information Screen 

 
The Environmental Information screen is used to enter climate information and building features needed to 
calculate certain air leakage test results such as the estimated annual and design infiltration rates, and the 
estimated annual cost of air leakage.  If any of the fields on this screen are left blank, the test can be 
completed, however, test results requiring those inputs will not be calculated or displayed on the Test 
Results screen.  All information entered on this screen is stored in both test and configuration files. 
 

To enter climate information, you can use the Select Climate Location button to select from a list of over 

200 cities, or you can click or Tab through the individual fields to enter the information manually.  To clear 

the Climate fields, click on the Clear button.  When you are finished entering environmental data, click on 

Next to move to the Mechanical Ventilation screen, or Previous to move back to the Building Information 
screen.    
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Environmental Information Screen 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Location Climate Characteristics: 

 
The program contains a listing of climate data from selected cities in the United States and Canada.  You 

can automatically load this information into the Climate Characteristics section by clicking on the Select 

Climate Location button, and then selecting the city closest to your test site using the Location selection 
field.   

 
Heating Degree Days:    Enter the number of base 65 degree F heating degree days for the location closest 
to the building being tested.  This field is used in the estimation of annual air leakage costs. 

 
Cooling Degree Days:   Enter the number of base 70 degree F cooling degree days for the location closest 
to the building being tested.  This field is used in the estimation of annual air leakage costs. 

 
Energy Climate Factor:   Enter the energy climate adjustment factor for the location closest to the building 
being tested.  The energy climate factor is used to estimate the average annual natural infiltration rates for 
purposes of estimating the annual cost of air leakage.  The energy climate factor is part of a simplified 
version of the LBL infiltration model developed by Max Sherman, and is discussed in more detail in 
Appendix E of the Operation Manual for the Model 3 Minneapolis Blower Door.  The calculation 
procedure for estimating the annual cost of air leakage can be found in the Model 3 Blower Door Operation 
Manual.   

 
Ventilation Weather Factor:   Enter the ventilation weather factor for the location closest to the building 
being tested.  The ventilation weather factor is used to estimate the average annual natural infiltration rate 
for purposes of estimating ventilation rates due to infiltration.  Ventilation weather factors used in 
TECTITE can be found in ASHRAE Standard 136.  The calculation procedure used to estimate average 
annual infiltration rates is based on ASHRAE Standard 136. 

 
Design Winter Temperature Difference and Wind Speed:   Enter the design winter temperature 
difference and wind speed for the location closest to the building being tested.  The design winter 
temperature difference and wind speed are used to calculate the infiltration rate under design winter 
conditions.  The estimated design infiltration rate can be used in ACCA Manual J load calculations in lieu 
of Manual J’s infiltration estimation procedure.  The calculation procedure used to estimate design  
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infiltration rates is based on the LBL infiltration model and is discussed in more detail in the ASHRAE 
Fundamentals Handbook, Chapter on Infiltration and Ventilation. 

 
Design Summer Temperature Difference and Wind Speed:   Enter the design summer temperature 
difference for the location closest to the building being tested.  The design summer temperature difference 
and wind speed are used to calculate the infiltration rate under design summer conditions.  The estimated 
design infiltration rate can be used in ACCA Manual J load calculations in lieu of Manual J’s infiltration 
estimation procedure.  The calculation procedure used to estimate design infiltration rates is based on the 
LBL infiltration model and is discussed in more detail in the ASHRAE Fundamentals Handbook, Chapter 
on Infiltration and Ventilation. 
 

Heating and Cooling Equipment Information: 

 
Heating Fuel Type:   Click on the fuel type used for heating. 

 
Heating Fuel Costs:    Enter the fuel cost for the selected heating fuel type.  For example, for natural gas 
(Gas), enter the cost in $ per CCF. 

 
Heating Efficiency:   Enter the annual seasonal efficiency (i.e. AFUE) for the heating system.  For 

example, for a gas furnace with an 82.5% AFUE, enter 82.5.  Note:  If the building is heated with an 
electric heat pump, use the HSPF or COP rating. 

 
Elect. Cost for Cooling:   Enter the $ cost per KWH for the cooling system.  For example, enter 0.08 if 
your electrical rate is 8 cents per KWH. 

 
SEER Rating of Cooling System:   Enter the SEER rating for the cooling system. 
 

Wind Shield Factor:   Click on the appropriate building wind shielding class.  The windshield factor is 
used in the infiltration model which estimates natural infiltration rates. 
 

Shielding Class Description: 
 

  Heavy:   Very heavy shielding; large obstructions surrounding the perimeter  
    within two building heights; typical downtown shielding. 

  Shielded:  Obstructions around most of the perimeter, building or trees within 30  
    feet in most directions; typical suburban shielding. 

  Moderate:  Some obstructions within two building heights, thick hedge, solid  
    fence or one neighboring building. 

  Light:  Few obstructions, a few trees or a small shed. 

  Exposed: No obstructions. 
 
 

6.3  Mechanical Ventilation Screen 

 
This screen is used to determine if whole-building mechanical ventilation calculations (based on ASHRAE 
Standard 62.2-2010) will be performed and reported by TECTITE.  In addition, the inputs necessary to 
calculate the alternative compliance supplement for existing houses (Appendix A of 62.2-2010) can be 
entered from this screen.  
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Mechanical Ventilation Screen 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To perform the whole building mechanical ventilation calculations, click the check box at the top of the 

screen.  Once the calculation feature is checked, you must choose between New House and Existing 

House. 
 

New House:   When New House is selected, it is assumed that the Local Exhaust Airflow requirements of 
Standard 62.2-2010 have been met and TECTITE simply calculates the whole-building ventilation 
requirements based on occupancy and floor area.   
 

Existing House:   When Existing House is selected, the user must input information for the Kitchen and 
Bathrooms of the house (including rated or measured fan flow rates, and the presence of operable 
windows).  From this information TECTITE calculates any necessary supplemental whole-building 
ventilation requirements for the house due to ventilation deficits in the Kitchen and Bathrooms.  The 
calculated supplemental ventilation is then added to the whole-building requirements that are based on 
occupancy and floor area.  An adjustment to whole-building requirements is also made by applying an 
Infiltration Credit based on the results of the Blower Door test using the methodology contained in 62.2-
2010. 
 

To clear the Mechanical Ventilation screen, click on the Clear button.  When you are finished entering 

information on this screen, click on Next to move to the Comments screen, or Previous to move back to the 
Environmental Information screen. 
 
 

6.4  Comments Screen 

 
The Comments screen can be used to enter an unlimited number of lines of comments on the building being 
tested.  Comments are saved along with the building test file and are printed out as part of the test report.  
Typical comments entered on this screen include client interview information, building and weather 
conditions during the test, and the location of major air leakage sites.  To begin entering comments, click 

anywhere within the comment box to activate the cursor.  To clear the Comments screen, click on the Clear 

button.  When you are finished entering comments, click on Next to move to the Test Settings screen, or 

Previous to move back to the Mechanical Ventilation screen. 
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Note:  You can access standard Windows copy and paste commands within the Comments screen by  
clicking on the right mouse button.  This allows you to easily move text between TECTITE and other text 
editing programs such as Microsoft Word.   
 
 

6.5  Test Settings Screen 

 
The Test Settings screen is used to set up the airtightness test procedures to be used by the TECTITE 

program.  To edit the Test Settings screen, click on individual fields, or use the Tab key to quickly move 

between fields.  When you are finished selecting test settings, click on Next to move to the Test Graph 

screen, or Previous  to move back to the Comments screen.  
 

Note:  When using the Manual Method for data entry, only the Standard and Method fields are active. 
 

Test Settings Screen 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Test Standard:   Choose from the following four Test Standards: 
 

� CGSB (149.10-M86):   The Canadian General Standards Board standard consists of an 8 
point Blower Door test conducted at target building pressures varying from 50 to 15 Pascals.  
A single pre and an optional post test baseline building pressure reading are taken.  The CGSB 
standard allows for either a depressurization test, or a pressurization test to be performed. 

 

� RESNET One-Point:   The RESNET One Point standard consists of a single-point Blower 
Door test performed at a target building pressure 50 Pascals.  A series of 5 pre-test baseline 
building pressure readings are taken to determine the accuracy level of the test.  The RESNET 
One Point standard allows for either a depressurization test, or a  pressurization test to be 
performed. 

 

� RESNET Multi-Point Test:   The RESNET Multi-Point standard consists of an 8 point 
Blower Door test conducted at a minimum of 8 target building pressures.  The target building 
pressures may vary from 60 to 15 Pascals, and both a single pre and post test baseline building 
pressure reading are taken.  The calculated uncertainty in CFM50 is used to determine the 
accuracy level of the test.  The RESNET Multi-Point Standard allows for either a 
depressurization test, or a pressurization test to be performed. 
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� RESNET Repeated Single-Point Test:   The RESNET Repeated Single-Point standard 
consists of a series of repeated single-point tests (minimum of 5 repeated tests) conducted at a 
target building pressure of 50 Pascals.  Each test includes a single pre-test baseline building 
pressure reading.  The calculated uncertainty in CFM50 is used to determine the accuracy 
level of the test.  The RESNET Repeated Single-Point standard allows for either a 
depressurization test, or a pressurization test to be performed. 

 
The choice of Test Standard will affect the data entry requirements and the test results.  

 
Method:   Click on Manual if you will be manually entering the Blower Door airtightness test readings 

(i.e. building and fan pressure readings).  Select Auto if a fully automated test will be performed including 

computerized control of the Blower Door fan.  Select Semi-Auto if the test data will be collected 
automatically, but the Blower Door fan will be controlled manually. 
 

Test Mode:   Click on Pressurize if the Blower Door will be blowing air into the building (i.e. the building 

will be at a higher pressure than outside), or select Depressurize if the Blower Door will be blowing air out 
of the building (i.e. the building will be at a lower pressure than outside). 
 

Test Pressures (only available for CGSB and RESNET Multi-Point Tests - when Auto and Semi-Auto 
Methods are selected):    
 

� Default:    the test will be performed at the target building pressure values specified in the 
selected test standard.  For most users, this is the preferred test method. 

 

� Custom:    allows the user to create a custom list of up to 12 target building target pressures at 

which Blower Door data will be collected.  Once Custom has been selected, click on the Edit 

Custom Pressures button to open the list of custom target building pressures.  Click on the 

Help button on the custom pressure list window for more information. 

 
Zonal Pressures (only available for CGSB Tests - when Auto or Semi-Auto Methods are selected):    
If you are using multiple DG-700 gauges (1 primary and up to 3 auxiliary gauges), or an APT System with 

3 or more pressure channels, you can activate the Zonal Pressures feature (by clicking on the Active button) 
to allow the simultaneous measurement of building zone pressures during the Blower Door test.  Once 

activated, the Settings button can be used to access the Zonal Pressures Set-Up screen.  Click on the Help 
button in the Zonal Pressures Set-Up screen, or refer to Chapter 10 for more information on using this 

feature.  Note: This feature is currently not available for DG-1000 gauges. 

 
Auto Test Parameters (only available when Auto or Semi-Auto Methods are selected):  
 

� Samples Per Station:   This field is only available if the CGSB test standard is selected and 
controls the number of readings (or samples) of building pressure and fan flow that are taken 
at each pressure station (i.e. target building pressure) during an automated test.  Each reading 
or sample is displayed on the graph as a small dot as it is collected.  The default number of 
samples is 100, and should work fine for most test applications (you may vary this number 
from 1 to 1000).  In most cases, larger numbers of samples will lead to higher correlation 
coefficients.  This field also controls the number of pre and post test baseline building 
pressure readings that are taken during an automated CGSB test sequence.  If the Zonal 

Pressures feature is active, the Samples Per Station also determines the number of zone 
pressure measurements taken for each active zone pressure channel.  
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� Time Averaging Period:   This field is only available if one of the RESNET Test Standards 

is selected.  The Time Averaging Period controls the length of time that each baseline 
building pressure, building test pressure, and fan flow readings are taken during the test.  For 

all three RESNET test standards, the Time Averaging Period should be at least 10 seconds. 
 

� Fan Adjust Rate (not available when Semi-Auto is selected):   During either an automated 
airtightness test or a cruise procedure, the computer is in charge of adjusting the fan speed to 

reach the desired (or target) building pressures.  The Fan Adjust Rate determines how 
quickly the fan speed changes as the computer tries to achieve the target building pressure.  

For most cases, the factory default Fan Adjust Rate of 1.0 will work fine. In some cases, such 
as windy weather, it may be necessary to reduce the fan adjust rate to prevent the fan from 
responding too quickly to pressure changes caused by the wind.  In such cases, try a lower 
setting (e.g. 0.2 or 0.1) so that  the fan adjusts slowly enough to successfully complete the test.  
If you would like to speed up fan response, try a higher setting (e.g. 2.0 or 3.0). 

 

Note:  When changing the Fan adjust rate, do not enter values greater than 5 or less than 0.1.  
In addition, the fan speed can be manually adjusted by dragging the manual fan speed 

adjustment slider on the Test Graph, or by pressing down on the Up and Down arrow keys 
(the arrow keys are only active when the manual adjustment slider is highlighted). 
 

� Target Tolerance (not available when Semi-Auto is selected):   The Target Tolerance is 
used by TECTITE to determine whether the measured building pressure is close enough to the 

target building pressure so that data collection may begin.  The Target Tolerance is a number 
(in Pascals) stating how close the actual building pressure needs to be to the target pressure 
before a reading will be taken.  In most cases the factory default setting of 2 (Pa) works fine. 
In windy weather you may need to increase the target tolerance (e.g. 3 or 4) to account for the 

fluctuations in building pressure caused by the wind.  The Target Tolerance used has little 
impact on the final test results, but your particular test standard (e.g. CGSB) may require you 
to get very close to your target pressures. 

 

Note:  If during an automated test you would like to manually instruct the computer to go 

ahead and take data, click on the Sample button.  At this point the computer will proceed with 
data collection just as if it had decided that the target tolerance had been met. 

 

� Building High Pressure Limit:   If TECTITE detects a building pressure higher than the set 

Building High Pressure Limit, the fan will shut off immediately and you will be informed 

that the maximum allowable building pressure was exceeded.  The purpose of the Building 

High Pressure Limit is to prevent damage to the building from excessive test pressures.  The 
default setting is 90 Pa.  If the maximum allowable building pressure is exceeded during a 
Semi-Auto test, you will see a warning message and should immediately shut down the fan.  

Note: The Blower Door fan calibration parameters are not accurate above test pressures of 
100 Pa. 

 

� Fan Start % (not available when Semi-Auto is selected):   Enter a number, typically in the 
range 1% to 25%.  At the beginning of an automated test or cruise procedure, the fan output 
signal from the gauge or DAB will immediately be set to this value to reduce the delay 
associated with fan startup.  A good value for this parameter can be determined by manually 
moving the fan control slider and estimating at which point the fan begins to turn.  This allows 
you to customize the computer control to the particular combination of fan motor and 
controller being used.  This value is stored in the building test files (.bld) and configuration 
files (.cfa).  The default value is 0. 
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The Fan Start % setting will not affect the minimum fan output which may occur during 
cruising or automated testing.  The computer will still be allowed to reduce the fan output 

below the Fan Start % value if needed to achieve low target pressures. 
 

Note:  If you input an inappropriately high Fan Start %, the fan will begin operation at a 

high speed and may trigger the warning message (Exceeded Maximum Building Pressure).  

Reduce the Fan Start % setting if this occurs. 
 

� Restore Factory Settings:   The Restore Factory Settings button will restore the factory 
default settings for all five Auto Test Parameter fields. 

 
Set as Defaults for New Tests:   Clicking on this box will save the currently selected Standard, Method, 
Test Mode and Auto-Test Parameters so that they will be used for all future new tests.  
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Chapter 7    Conducting an Automated Airtightness Test 

 
 

7.1  Overview of Test Graph Screen (Auto Method) 

 

The automated airtightness test is conducted from the Test Graph screen.  The main feature of the Test 
Graph screen is a plot of Blower Door fan airflow (or building leakage) on the vertical axis versus building 
pressure on the horizontal axis.  During a Blower Door test, data are automatically collected at a series of 
pre-set target building pressures, which are designated by the vertical (blue) lines on the graph.  The target 

building pressures are determined in the Test Pressures section of the Test Settings screen.   
 

Test Graph Screen (Auto Method) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
*   Building pressure values shown on the graph and in the Bldg Pressure status window are adjusted for the     
     measured baseline pressure. 
** Zonal pressure values shown in the Zone Pressure status windows are adjusted for measured zonal   
     baseline pressure. 

 
During a fully automated test sequence, the Blower Door fan will turn on and increase speed until the 
building pressure reaches the highest target pressure line shown on the graph (e.g. 50 Pa for a CGSB test).  
Once the appropriate building pressure is achieved, TECTITE takes a number of simultaneous 
measurements of building pressure and fan airflow (the default number of samples is 100 for a CGSB test).  
Each sample is displayed on the graph as a small dot as it is collected.  When the system is finished 
collecting samples for the first target pressure line, the average value of all samples for that target pressure 
is displayed as a red circle.  The fan speed is then reduced until the building pressure reaches the next target 
pressure line and the data collection process is repeated. The number of data samples taken at each target 

building pressure is determined by the Samples per Station field in the Test Settings screen.  Once data has 
been collected at each target pressure, a best fit regression line is drawn through the data points. 

Current Zone Pressures (only if Zones active) ** 

Selected Fan Model, 

Test Mode and 

Flow Ring 

Manual Fan  

Speed Control 

Real-Time ACH50 

Estimator (only for 

Cruise and Monitoring) 

Current Fan Flow 

And Fan Pressure 

Current Building 

Pressure * 

Baseline Building 

Pressure 

Completed Test 

Indicator 

Sample Counter 

 

Flow Through the 

Blower Door Fan 

(Building Leakage) 

Pressure Difference Between Inside 

And Outside (Building Pressure) * 

 

DAB Status Box 

 

Blower Door Data 
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Note:  If you are conducting a Semi-Automated test sequence, you will need to manually adjust the 

Blower Door fan to achieve the appropriate building pressure, and then press the Sample button to 
initiate the automated measurement of building pressure and fan flow.   

 

If the Zonal Pressures feature has been activated from the Test Settings screen, the Zone Pressure status 
window will display the current measured zone pressures during the course of the automated test.  While 
TECTITE is collecting data for the building airtightness test (from Channels P1 and P2), it will also collect 
data from each active zone pressure channel (P3 – P8).  The number of data samples taken for each active 

zone pressure channel is determined by the Samples per Station field in the Test Settings screen. 
 
In addition to the graphical display, the TECTITE program will provide a series of messages or prompts on 
the Test Graph Screen to ensure that proper testing procedures are followed.  The program also detects 
common testing or equipment problems (e.g.  tubing connected to the wrong  pressure tap) and provides a 
warning message to the operator. 
 
 

7.2  Selecting the Fan Model 
 
Before beginning a test, be sure that the selected fan model displayed at the top right side of the Test Graph 
screen matches the Blower Door fan being used.  To change the selected fan model, click on 

Options…Equipment Info from the Main TECTITE Menu.   
 

Equipment Information Window 

 

In the Equipment Information window, select the appropriate fan model, and then click on OK.  You may 
also input a fan serial number which will be stored along with the building test file, and is printed out on the 
test report.  Importantly, if you change the selected fan model while test data are displayed on the graph, the 
test data will be automatically cleared.   
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7.3   Establishing a Communication Link(s) 

 

Establishing Communication Between TECTITE and the DG-700, DG-1000 or APT DAB: 

 
Before beginning an automated test or cruise procedure, TECTITE checks to be sure that your computer is 
communicating properly with the DG-700, DG-1000, or APT DAB(s) that will be used for the test.  
Automated testing, Semi-Automated testing or cruising cannot begin until the necessary communication 
link(s) have been established.  Once the proper communication links have been established, the message 

Idle - Monitoring appears in a green DAB Status window at the bottom of the Test Graph screen and the 

Start Test button is activated. 
 

� Primary Device:  The Primary Device is the DG-700, DG-1000 or APT DAB that will be 
used to measure building pressure and fan flow during the Blower Door test.   
 

Checking the AUTO SELECT button in the Device Connection window will allow TECTITE 
to automatically search for TEC devices on all available communication ports and wireless 

networks on your computer.  AUTO SELECT is the preferred option to establish 

communication with your TEC Device.  AUTO SELECT will attempt to establish a 
communication link with the first Energy Conservatory Device that it finds.  If a 

communication link is established, this device is considered the Primary Device.  Wireless 

communication is only enabled when AUTO SELECT is checked.  
 

If you uncheck AUTO SELECT, you may specify a Primary COM Port (COM 1 through 
COM 256) to connect with a DG-700 gauge or with an APT DAB.   

 

Device Connection Window 
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� Aux:  Aux Device(s) are additional DG-700s or APT DABs that can be used exclusively to 

measure zonal pressures during the Blower Door test.  The Aux COM Port(s) are the 

communication ports on your computer that will be used to communicate with the Aux 

Device(s).  Aux Devices can only be used with the Zonal Pressures feature of TECTITE. This 

version of TECTITE does not support wireless or Ethernet connections to Aux Devices. 

 

Note:  If the Primary Device is an APT DAB with 3 or more pressure channels, you can use 
installed pressure channels 3 through 8 on the APT DAB along with the Zonal Pressure 

feature, without specifying an Aux COM Port. 
 

� Scanning for Devices:  The easiest way to quickly check your computer for all currently 

connected Energy Conservatory Devices is to use the Scan for Devices button in the Device 

Connection window.  Once the Scan window is open, clicking on Start Scan will provide a 
list of all Energy Conservatory Devices that TECTITE can currently locate and establish a 
communication link with.  The list includes devices connected through all wired 
communication ports, and through the computer’s wireless network adapter.   

 

Note:  The Energy Conservatory Device must be ON to be detected. 
 
For more information on establishing communication between your computer and a DG-700, DG-1000, and 
DAB, see Chapter 15. 
 
 

7.4 Starting an Automated Test 

 

Start Test Button: 

 

Clicking on the Start Test button will begin an automated airtightness test sequence.  The TECTITE 
program will guide you through the test sequence using a series of operator messages.  
 
A fully automated test sequence includes the following steps: 
 
1. The operator is prompted to enter specific environmental data (temperatures, barometric pressure, etc.) 

for the test being performed. 
2. The operated is prompted to cover the fan inlet so that the TECTITE can measure the baseline building 

pressure (due to wind and stack effects) prior to the test.  Install the flow ring set including the no-flow 

plate or install a nylon fan cap to cover the fan inlet opening, then click on OK. 
3. TECTITE will automatically begin to measure the pre-test baseline building pressure.  The number of 

building baseline readings made will depend on the selected Test Standard and Samples per Station 
fields in the Test Setting screen.  Once the pre-test baseline measurement is completed, the average 

value of  the baseline readings is displayed in the Bldg Baseline (Pa) status window on the right side of 
the screen.  All subsequent building pressure measurements shown on the graph and in the Building 
Pressure status window will be adjusted by this measured baseline pressure.  TECTITE will also 
measure the baseline pressure for any active zone pressure channel at the same time.  

4. The operator is prompted to remove the fan inlet cover and install the appropriate flow ring on the fan 
for the beginning of the test.  Use your best judgment and install the flow ring that you think will 
provide the correct airflow for the highest target pressure.  Don’t worry if you guess wrong, the 
program will instruct you to install a different ring later on if you start with the wrong one.  Click on 

OK after you’ve removed the inlet cover and installed the chosen flow ring.    
5. The operator is now prompted to indicate which flow ring was installed on the fan.  Select the 

appropriate ring and click on Proceed with Test. 
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6. The fan will automatically turn on and increase speed until the building pressure reaches the highest 

target pressure line shown on the graph.1   The current fan airflow and building pressure is shown on 
the graph by the moving Fan Airflow and Building Pressure Cursor.  Once the appropriate target 
building pressure is achieved, TECTITE takes a number of simultaneous readings of building pressure 
and fan airflow.  Each reading is displayed on the graph as a small dot as it is collected.  Once the 
program is finished collecting readings for the first target pressure line, the average value of all 
readings for that target pressure is displayed as a red circle.  The fan speed is then reduced until the 
building pressure reaches the next lowest target pressure line and the data collection process is 

repeated.  Note:  If the Zonal Pressures feature has been activated from the Test Settings screen, the 
Zone Pressure status window will display the current measured zone pressure during the course of the 
automated test.  While TECTITE is collecting data for the building airtightness test (from Channels P1 
and P2), it will also collect and store data from each active zone channel (P3 – P8).   

7. After data have been collected for the last target pressure line, the fan turns off and the operator is 
again prompted to cover the fan inlet for another set of baseline building pressure readings.   

8. All data are now automatically adjusted for the average of the two baseline readings, and the test is 
completed.  A “best fit” line is then drawn through the data points (i.e. red circles) on the graph. 

9. Calculated test results can be seen by clicking on Next. The measured zone pressure data are available 

from the Zone Data screen (click Next from the Test Results Screen, or use the Goto Menu Item). 
 

 

Using the Sample Button (manually activating data collection): 

 

The Sample button is used to manually activate data collection for a target building pressure line during an 
automated test sequence, rather than waiting for TECTITE to automatically activate data collection.  This 
button is particularly useful if it is windy and the building pressures are fluctuating causing a long time 
delay before automated data collection begins at each target pressure line. In addition, if you are conducting 

a Semi-Automated test, you must use the Sample button to initiate the data collection process. 
 

Using the Clear Button (Clearing Data From the Graph): 

 

The Clear button is used to clear all Blower Door data from the graph.  This will not affect the information 

that you have entered into the test input screens, or any results that you have previously saved.  Clear is 

typically used to prepare the graph for a new test.  Clicking on the Clear button will also clear all stored 
zone pressure data. 
 

Conducting and Displaying Multiple Tests on the Same Graph: 
 
Data from more than 1 automated test can be displayed on the Test Graph at one time if you are conducting 

a CGSB test.  This occurs when conducting a second airtightness test (using Start Test) and not clearing 
data before beginning the next test.  If data from multiple tests with the same test mode are displayed on the 
graph (for example, 2 depressurization tests), test results are calculated using all displayed data.  The main 
reason for combining multiple tests with the same test mode is to increase the repeatability of test results.  
This is particularly useful in windy weather. 
 

The Completed Tests indicator, located on the right-hand side of the Test Graph Screen, shows the total 
number of completed tests being displayed on the graph.   

                                                 
1   If the program is unable to reach the highest target pressure line with the fan running full speed, the operator will be 
prompted to change to the next larger flow ring.  If the fan is in open configuration and still not able to reach the 
highest target pressure line, the program will display the message “Can’t Reach Target Pressure...Collecting Data at 
Highest Building Pressure” (see Section below  - Operator Messages During the Automated Airtightness Test). 
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Using the Pause Button: 
 

Once an automated test has been initiated, the Pause button can be used to temporarily pause the test 

sequence.  After clicking on Pause, the fan will turn off and the message The Test Is Paused appears on 
screen.  From this message box, the user has 3 options: 
 

� Clicking on Adjust Auto Test Settings allows you to change the Fan Adjust Rate, the Target 

Tolerance, the Building High Pressure Limit and the Fan Start % fields during the middle of 
a test.  

 

� Clicking on Proceed With Test will restart the test sequence from where the Pause button 
was activated. 

 

� Clicking on Stop Test allows you to end the current test sequence.  
 
 

7.5  Stopping an Automated Test 

 

In addition to using the Pause button, the fan can be quickly turned off during a test by pressing the Esc 

key, or by clicking on the Stop Test button.  After the fan has been turned off, the user can choose to end 
the current test sequence, or can restart the test.  If data from more than one test are being displayed on the 
graph, stopping a test will not clear data from previously completed tests.  In addition, stopping a test will 
not affect information that you have typed into the test input screens, or any test results that you have 
previously saved. 
 
 

7.6  Adjusting the Auto Test Parameters  
 

The Test Settings screen contains a number of  Auto Test Parameter fields which are used to adjust data 
collection and fan control variables during the automated test sequence.  Refer to Chapter 6 for a detailed 

description of each of the Auto Test Parameter fields.  As noted above, the Auto Test Parameters can 

also be adjusted in the middle of a test sequence by clicking on the Pause button. 
  
 

7.7  Operator Messages During the Automated Test 

 
During the airtightness test, TECTITE provides a series of on-screen messages or prompts to the operator to 
ensure that proper testing procedures are followed.  In addition, the program detects common testing or 
equipment problems (e.g.  tubing connected to the wrong pressure tap) and provides a warning message to 
the operator.  On the following pages is a listing of many of the on-screen test procedure and operator 
warning messages provided by the TECTITE program: 
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On- Screen Procedure Messages    Operator Action Required    

Cover fan inlet to measure starting 

building pressure baseline.  Press OK 

when ready.            or 

 

Cover fan inlet to measure ending building 

pressure baseline.  Press OK when ready. 

Cover the fan inlet so that TECTITE can measure the baseline building 
pressure (due to wind and stack effects) prior to, or following completion 
of the test.  Install either the no-flow plate or the nylon fan cap to seal off 
the fan inlet opening.  

Remove fan inlet cover and install 

appropriate flow ring.  Press OK when 

ready. 

Remove the no-flow plate or nylon fan cap from the fan inlet so that the 
fan can be turned on.  Install the flow ring that you think will provide the 
appropriate air flow for the beginning of the test. 

Which flow ring is installed? Select the flow ring that is currently installed on the fan, and then click on 

Proceed with Test. 

Install Ring _  and press here to continue 

test,  OR   Press here to end test at 

previous test pressure.  

The program has determined that a different flow ring should be installed 
on the fan.  Install the ring listed in the message.  If the listed ring is not 
available, or you wish to end the test at this point, click on the end test 

message.2 

Remove all rings and press here to 

continue test,  OR   Press here to end test 

at previous test pressure.   

The program has determined that all flow rings should be removed from 
the fan.  Remove all rings from the inlet of the fan.  You may also select 
to end the test at this point.   

This will end testing.  Do you wish to end 

it?                         or      

 

This will end cruising.  Do you wish to end 

it?   

This message appears when you have pressed Esc or clicked on Stop Test 
during a test, or while the cruise control feature is active.  To end the test 

or turn off cruise control, click on Yes. 

 

On-Screen Warning Messages     Operator Action Required 

Can not reach target pressure and have 

open fan.  Collecting data at highest 

building pressure. 

No action required.  If the fan is in open configuration (i.e. no flow plates 
installed), running at full speed, and not able to reach the target pressure 
line, TECTITE will automatically collect data at the highest achievable 
building pressure. 

Warning:  Wrong sign (+/-) on building 

pressure.  Check A/P1.  Do you wish to 

terminate test? 

The measured building pressure on Channel A/P1 is changing in the 
wrong direction from the indicated Test Mode.  Check to be sure the A/P1 
Reference tap is connected to the outside, the A/P1 Input tap is measuring 
the pressure inside of the building, and that the direction of the Blower 
Door fan flow is consistent with the indicated Test Mode (i.e. 

depressurization vs. pressurization). Click on Yes to end the test and No 
to continue the test. 

Warning:  Wrong sign (+/-) on fan 

pressure.  Check B/P2.  Do you wish to 

terminate test?  

The measured fan pressure on Channel B/P2 is changing in the wrong 
direction.  Check to be sure the B/P2 Input tap is connected to the Blower 
Door fan, and the B/P2 Reference is measuring the pressure in the space 

upstream of the fan inlet.  Click on Yes to end the test and No to continue 
the test. 

Warning:  Not detecting fan pressure.  

Check B/P2.  Press OK to terminate test.    

 

 

 

The measured fan pressure on Channel B/P2 is less than 1 Pa, but the 
building pressure is changing.  Possible fan pressure tubing disconnect.  
Check to be sure the B/P2 Input tap is connected to the Blower Door fan, 
and the B/P2 Reference is measuring the pressure in the space upstream 

of the fan inlet. Click on OK to end test. 

Warning:  Not detecting fan or building 

pressure.  Check system.  Press OK to 

terminate test. 

The program is not detecting a fan or building pressure reading, even 
though the program is calling for full fan speed.  Check building and fan 
pressure tubing connections to the TEC Device.  If the fan was not 
running, check the fan speed controller to make sure:   
- It is properly connected to the fan and plugged into power.   
- The speed control knob is turned on. 
- The speed controller is connected to the TEC Device. 

Click on OK to end test. 

                                                 
2  If you end the test and data has been collected for at least one previous target pressure line, test results will be 
calculated using all data collected prior to ending. 
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On Screen Warning Messages   Operator Action Required 
Warning:  At full fan speed but <2 Pa 

building pressure.  Check system.  

Press OK to terminate test.  

The measured building pressure on Channel A/P1 is less than 2 Pa when the 
fan is at full speed.  First check that the A/P1 Reference tap is connected to 
the outside, and the A/P1 Input is measuring the pressure inside of the 
building.  Second, check that outside windows and doors in the building are 
closed and that there are no other large openings to the outside preventing 

the building pressure from changing. Click on OK to end test. 

Warning:  Not detecting building 

pressure on A/P1. 

The program is not detecting a change in building pressure, even though the 
fan pressure is at least 50 Pa.  Check that  one end of the (green) building 
reference tubing is connected to the A/P1 Reference tap, and that the other 
end is placed outside of the building and away from the Blower Door fan 

flow.  Click on End Test to terminate test. 
 
Advanced Users:  If you are conducting an advanced  procedure where you 
are trying to maintain or measure very small (or zero) building pressures 
(e.g. “cruising zero”), you can  temporarily turn off this message by checking 

the Turn off this warning box. 

Warning:  Excessive building pressure 

fluctuation for the current target 

pressure.   

While attempting to reach a target pressure line, the measured building 
pressure has been fluctuating beyond the Target Tolerance for more than 90 
seconds.  To determine the cause of the fluctuating building pressure 
problem, and the appropriate operator action,  see Chapter 15 – Problem 3.  

To make changes to the auto test settings, click on Adjust Auto Test 

Settings, to proceed with the test, click on Proceed with Test, or to end the 

test, click on Stop Test. 

Warning:  Maximum allowable 

building pressure exceeded. 

The default maximum allowable measured building pressure is 90 Pascals.  
This maximum pressure is designed to prevent accidental damage to the 
building being tested.  In addition, calibration formulas for the Blower Door 
fans may not be accurate at back pressures greater than 90 Pascals, 
depending on the flow ring installed and the fan pressure.   
 

If you set the Fan Start % setting too high, the fan will begin operation at a 

high speed and may inadvertently trigger this warning.  Reduce the Fan 

Start % setting if this occurs. In addition, lowering the Fan Adjust Rate 
setting may also help to prevent this message inadvertently being triggered 

(the Fan Start % and Fan Adjust Rate can be changed by clicking on the 

Adjust Auto Test Settings button in the warning screen).  To proceed with 

the test or cruise procedure, click on Proceed with Test/Cruise, or to end 

the procedure, click on Stop Test/Cruise.. 

No test pressures available.  No test pressures have been selected in the Test Pressures field in the Test 
Settings screen.  Automated testing can not begin until test pressures have 
been entered, or the default pressure setting is selected. 

Data for more than one test will be 

combined on the graph. 

Data from more than 1 automated test with the same test mode can be 
combined and displayed on the Test Graph at one time.  This occurs when 

conducting a second airtightness test (using Start Test) and not clearing 
data before beginning the test.  The main reason to combine data from 
multiple automated tests (with the same test mode) is to increase the 
repeatability of the test results in windy weather. 
 
If you start a new test while data are currently displayed on the graph, a 
warning message appears to let you know that you are attempting to combine 
data from multiple tests.  If you would like to save the current test data to a 

file before adding additional data points, you will need to select Cancel Test 
and save the data file before proceeding.  
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On Screen Warning Messages             Operator Action Required 
Communication lost.  Testing ended. 

 

                             or 

 

Communication lost.  Cruising ended. 

Communication between the TEC Device and your computer have been 
disrupted, and the current test or cruise procedure has been ended.  If you 
were conducting an airtightness test when communication was lost, the test 
sequence is ended and all data from the current test are cleared from the 
graph.  
 

Note:  If the fan is still running, it can be stopped by completely turning off 
the knob on the fan speed controller. 
 
Lost communication can be caused by a poor connection between the TEC 
Device and your computer, or by a loss of power to the Device.  If using a 
communication cable, check the connection between the computer and the 
TEC Device. If using wireless communication, try to move the computer 
closer to the Device. Also check that the Device has proper power or battery 

charge.  Click on OK to return to the Test Graph screen.  See Chapter 15 for 
more information on lost communications. 

Warning:  Flow too small to measure.  

Press OK to terminate test.   
You are trying to measure a fan flow below the acceptable operating range 

of the equipment.  Click on OK to end the test. 

Cannot start the test because there are 

not enough pressure channels for the 

existing test data.  Do you wish to 

clear the data, deactivate Zonal 

testing, and proceed with the test? 

You are trying to combine data for more than 1 test, and the current DAB 
being used has fewer pressure channels than were used during the first test.  
For example, this message would appear if a 5 pressure channel DAB was 
used to record 3 zone pressures during the first test, and you are now using a 

4 pressure channel DAB to combine data with the first test.  Click on Yes to 
clear all existing test data, deactivate the zonal testing feature, and proceed 

with a new test, or click on No to end the current test sequence.  

Low Battery Warning.  Press OK to 

end procedure. 

TECTITE has detected that the TEC Device battery is critically low.  The 
user is advised to end the current test sequence and do following action: 
 

DG-1000 

Plug in the power adapter to the device to recharge the Li-ion batteries. A 
full battery charge using the fast charger takes approximately 3 hours. The 
gauge can be operated while the batteries are charging. This warning is 
activated if TECTITE detects a battery voltage below 3.33V. The current 

DG-1000 battery voltage can be viewed by clicking on the Data Box Info 
button. 
 

DG-700 

Replace the 6 AA batteries (located in the compartment in the back of the 
instrument) before resuming testing.  Be sure the gauge is turned off before 
replacing the batteries.  This warning is activated if TECTITE detects a 
battery voltage below 5.6 volts. The current DG-700 battery voltage can be 

viewed by clicking on the Data Box Info button.  
 

APT DAB 

Plug in the power supply to the DAB.  You may need to let the DAB’s 
internal NiCd battery charge for 20-30 minutes before resuming testing.  The 
fully charged NiCd battery will power the DAB for approximately 6 - 12 
hours of testing.  If you are using your APT DAB for the first time, we 
recommend that you fully charge the DAB battery overnight before 
beginning testing.  The DAB can be also be operated with the power supply 
plugged in.  A green light located next to the 12V terminal on the DAB will 
turn on whenever the power supply is providing power.  The DAB's battery 
will charge even when the DAB is in operation, however the time required to 
fully charge the battery is increased. 
 

Click on OK to return to the Test Graph. 
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7.8  Manually Adjusting the Fan Speed 
 
The fan speed can be manually adjusted by dragging the manual fan speed control slider on the Test Graph 

screen, or by pressing down on the Up and Down arrow keys.  In order for the fan speed control slider to 
work, a communication link between the computer and TEC Device must have been established, and the 

message Idle - Monitoring should appear in the DAB Status Window.  
 
If you are conducting a Semi-Automated test, the manual fan speed control slider is not available, and you 
will need to manually turn the Blower Door fan speed controller knob in order to adjust the fan speed. 
 
 

7.9  Real-Time ACH50 Estimator 

  

During Idle - Monitoring (or when the Cruise Control feature is active), TECTITE can display a real-time 
estimate of Air Changes per Hour at 50 Pascals of building pressure in the ACH50 Estimator Window.  To 
estimate ACH50, TECTITE uses the current measured fan flow, the volume estimate input into the Building 
Information screen, and an assumed Building Leakage Curve exponent (n value) of 0.65.  The ACH50 
estimator window is only active when the current building pressure is between 40 and 60 Pascals, and a 
valid fan flow measurement is being made.  The Real-Time ACH50 display is useful for quickly estimating 
building leakage rates before conducting a full airtightness test.  
 

Note:  The Real-Time ACH50 estimator is not active during an automated test sequence. 
 

Real-Time ACH50 Estimator 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ACH50 Estimator Window 
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7.10  Using the Display Large Meters Feature 

 
The Display Large Meters feature replaces the graph on the Test Graph (Auto Method) screen with 3 large 
status windows showing Real-Time ACH50, Current Fan Flow, and Current Building Pressure.  The feature 

can be toggled on and off by clicking on Display Large Meters from the Options Menu. 
 
 
 
 
 
 
 
 
 
The Display Large Meters feature is particularly useful when looking at the computer screen from a distance 

while “Cruising” or manually adjusting the Blower Door fan in Idle-Monitoring mode.  The Real-Time 
ACH50 Status Window is only active when the current building pressure is between 40 and 60 Pascals, and 
a valid fan flow measurement is being made.  The Real-Time ACH50 display is not active during an 
automated test sequence. 
 

Display Large Meters Feature 
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Chapter 8     Using the Manual Data Entry Method  
 
 

8.1  Overview of Test Graph Screen (Manual Method) 

 
Manual Method is used to input Blower Door test data (e.g. building pressure and fan airflow readings) that 
were collected manually, rather than collected automatically by TECTITE.  The Manual Method option is 

only available if the Method field is set to Manual from the Test Settings screen 
 
The figure below shows a sample Test Graph screen when using Manual Method.  Like the Auto Method 
Test Graph screen, the main feature of the Manual Method Test Graph screen is a plot of Blower Door fan 
airflow (or building leakage) on the vertical axis versus building pressure on the horizontal axis.  However, 
when using Manual Method, all auto control buttons and status windows have been removed, and replaced 

with a Data Table button which opens a simple data entry table.  Test data entered into the Data Table are 
plotted on the graph, and a best-fit regression line is automatically drawn through the plotted data points.  
 

Test Graph Screen (Manual Method) 

 
 

8.2  Selecting the Fan Model 
 
Before entering data into the Data Table, select the Blower Door fan model being used for the test.  To 

select the fan model, click on Options located in the Main TECTITE Menu.  From the Options Menu, 

select Equipment Info.  In the Equipment Information window, select the appropriate fan model from the 
pull-down list.  
 
You may also input a fan serial number which will be stored along with the building test file, and is printed 
out on the detailed test report.  In addition, when conducting a Manual test, you can also input and store a 
micromonometer (gauge) serial number and custom calibration date.  If you are conducting an Automated 
or Semi-Automated test, the TECTITE software automatically stores the micro-monometer (TEC Device) 
serial number and calibration date as part of the building test file. 
 
 

Button to access manual 
entry Data Table.  

Pressure difference between inside 
and outside (Building Pressure) 
 

Flow through the 
Blower Door fan 
(Building 
Leakage) 
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Equipment Information Window (Manual Test) 

 

Note:  If you change the selected fan model while test data are displayed on the graph, the test data will be 
automatically cleared from the graph and the Data Table.   
 
 

8.3  Entering Test Data into the Data Table 
 
The Data Table screens allow entry of test data (building pressures and fan flows), plus baseline building 
pressures and environmental test data (temperatures and site altitude). 
 
The layout and required data entry of the Data Table depends on the selected Test Standard.  For each set of 
test readings, you must enter the measured building pressure (in Pa), the fan configuration corresponding to 
this set of readings (i.e. which Flow Ring was installed on the fan), and the measured fan flow used to 

generate the building pressure.  Fan flow can either be entered directly (by choosing the Flow button in the 

Flow Data Source field), or by entering the fan pressure signal in Pascals (by choosing the Fan Pressure 
button in the Flow Data Source field).  If you enter the fan pressure signal, the flow value will be 
automatically determined by TECTITE.   
 

Data Table for Manual Entry of Test Readings (CGSB Test Standard) 
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Data Table for Manual Entry of Test Readings (RESNET One-Point Test Standard) 

 

Data Table for Manual Entry of Test Readings (RESNET Multi-Point Test Standard) 

 
 

Data Table for Manual Entry of Test Readings (RESNET Repeated Single-Point Test Standard) 

 



 

Chapter 8   Using the Manual Data Entry Method 

TECTITE  
Version 4.0 - WiFi 

39

 

Entering Baseline Readings into the Data Table: 

 
The baseline building pressure is the pressure between the building and outside before the Blower Door fan 
is turned on.  Use of baseline pressure readings in the Table allows the program to quickly adjust the 
manually collected test readings for baseline stack and wind effects.  The process for entering the baseline 
pressure readings depends on which Test Standard is selected on the Test Settings screen. 
 

� Entering Baseline Readings for a CGSB Test. 
 

The CGSB test standard requires entry of a single Pre-Test baseline building pressure reading. You 
may also enter an optional Post-Test baseline reading.  Baseline readings are entered directly into 
the appropriate field in the Data Table.  If you leave the Post-Test baseline field empty, the 
program will simply use the Pre-Test reading when adjusting for baseline pressure effects. 
 

Note:  If you are using the DG-700 or DG-1000 built-in Baseline feature, enter 0 into the Pre-Test 
baseline field (you may leave the Post-Test baseline field blank).  This is because the Baseline 
feature has already adjusted the building pressure reading(s) for baseline effects. 

 

� Entering Baseline Readings for a RESNET One-Point Test.  

 
The RESNET One-Point Test standard requires that a series of 5 Pre-Test baseline building 

pressure readings be taken.  Click on the Enter/Edit Baseline Readings button to open a baseline 
entry screen.  Enter 5 separate pre-test baseline building pressure readings in this screen.  Be sure 
to include the proper sign of the reading when entering the values.  Once the 5 baseline readings 
are entered, the screen will display the average of the 5 readings, and the calculated range of the 
readings (i.e. the largest reading minus the smallest reading).   
 
If the calculated range of the baseline readings is greater than 10.0 Pa, the test is not valid and the 
operator is instructed to clear the baseline readings and to restart the test with a longer time 
averaging period.   
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Note:  Do not use the built-in Baseline feature with this Test Standard because you will need to 
take and enter 5 separate baseline readings as part of the test procedure.  

 

� Entering Baseline Readings for a RESNET Multi-Point Test. 

 
The RESNET Multi-Point Test standard requires that baseline building pressures be made both 
before (Pre-Test) and after (Post-Test) the test readings are taken with the Blower Door fan 
operating.  These baseline readings are entered directly in the appropriate Data Table fields.   

 

Note:  Do not use the built-in Baseline feature with this Test Standard because you will need to 
take both a Pre-Test and a Post-Test baseline building pressure reading.   

 

� Entering Baseline Readings for a RESNET Repeated Single-Point Test. 

 
The RESNET Repeated Single-Point Test standard requires that a Pre-Test baseline building 
pressures reading be taken for each repeated single-point test. Each row in the Data Table contains 
a field to enter the Pre-Test baseline reading.   

 

Note:  If you are using the built-in Baseline feature, enter 0 into the Pre-Test baseline field(s).  
This is because the Baseline feature has already adjusted the building pressure reading(s) for 
baseline effects. 

 

 

Entering Environmental Data into the Data Table: 

 

� CGSB Test:  Click on the Enter/Edit Temperature Data button to enter the Inside and 
Outside temperatures during the test.  

 

� RESNET Tests:  Click on the Enter/Edit Temperature and Altitude Data button to enter 
the Inside and Outside temperatures during the test, and the site altitude for the building being 
tested. 

 

 

Additional Tips on Using the Manual Data Entry Table: 

 

 All Test Standards: 

� Be sure you have the gauge set up properly (refer to your Blower Door or digital gauge 
manual).  If you have set the gauge up properly, building pressure readings will be read from 
Channel A, and fan flow readings will be read from Channel B. 

� Be sure to include the proper sign of all baseline readings. 

� If you are Depressurizing the building, enter the building pressure readings as negative 
numbers (TECTITE automatically places a negative sign in the building pressure entry fields 
if the Test Mode is set to Depressurize). 

� If you are Pressurizing the building, enter the building pressure readings as positive readings. 
 

CGSB Test: 

� If you are using the Baseline feature, enter 0 into the baseline fields.  This is because the 

Baseline feature has already adjusted the building pressure reading(s) for baseline effects.   

� Do not use the @50 feature when conducting a CGSB Test because you will need to enter test 
data at a variety of building pressures (CGSB Test requires 8 test readings)..   

 



 

Chapter 8   Using the Manual Data Entry Method 

TECTITE  
Version 4.0 - WiFi 

41

 

RESNET One-Point Test: 

� Do not use the Baseline feature when conducting a RESNET One-Point Test.  Five individual 
pre-test baseline readings are entered as part of the test data entry procedure. 

� If you are using the @50 feature to conduct the test, always enter the building pressure as 50 

Pa.  This is because the @50 feature automatically adjusts the displayed flow reading to a test 
pressure of 50 Pa. 

 

RESNET Multi-Point Test: 

� Do not use the Baseline feature when conducting a RESNET Multi-Point Test.  Two 
individual baseline readings (pre and post) are entered as part of the test data entry procedure. 

� Do not use the @50 feature when conducting a RESNET Multi-Point Test because you will 
need to enter test data at a variety of building pressures (RESNET Multi-Point Test requires 8 
test readings)..   

 

RESNET Repeated Single-Point Test: 

� If you are using the Baseline feature, enter 0 into the baseline fields.  This is because the 

Baseline feature has already adjusted the building pressure reading(s) for baseline effects.   

� If you are using the @50 feature to conduct the repeated tests, always enter the building 

pressure as 50 Pa.  This is because the @50 feature automatically adjusts the displayed flow 
reading to a test pressure of 50 Pa. 

 
 
When you are finished entering test data into the Table, click on OK to return to the Test Graph.  You can 

clear the Table at any time by clicking on the Clear Data button. 
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Chapter 9    Viewing Test Results  (Auto and Manual Method) 

 
 
Once an automated test has been completed, or test data have been manually entered into the Data Table, 
test results are automatically calculated using all data points displayed on the graph, and values entered into 

the input screens.  To view the Test Results screen, click on Next from either Test Graph screen.  
 

Test Results Screen (CGSB Test Standard) 

 
 

9.1  Overview of Test Results Screen 
 

Airflow At 50 Pascals:      

      

� CFM50:  This is the airflow needed to create a change in building pressure of 50 Pascals, and 
is the most commonly used measure of building airtightness.      

      

� ACH50:  The Air Changes per Hour at 50 Pascals is another commonly used measure of  
building airtightness.  ACH50 is the number of complete air changes that will occur in one 
hour with a 50 Pascal pressure being applied uniformly across the building envelope.  ACH50 
is a useful method of adjusting (or normalizing) the building leakage rate by the size (volume) 
of the building.  If you did not enter the building volume on the Building Test Info screen, 
ACH50 will not be calculated.   

      

� CFM50/ft2 Floor Area:  This is the CFM50 divided by the entered floor area of the building.  
This calculation adjusts (or normalizes) the building leakage rate by the floor area of the 
building.  If you did not enter the floor area on the Building Test Info screen, this variable will 

not be calculated.   Note:  Only displayed when using the CGSB Standard.   
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� CFM50/ ft2 Surface Area:  This is the CFM50 divided by the entered surface area of the 
building.  This calculation adjusts (or normalizes) the building leakage rate by the surface area 
of the building.  If you did not enter the surface area on the Building Test Info screen, this 

variable will not be calculated.  Note:  Only displayed when using the CGSB Standard.   
 

 

Leakage Areas:      

      
Once the leakage rate for the building has been measured, it is useful to estimate the cumulative size of all 
leaks or holes in the building's air barrier.  The estimated leakage areas not only provide us with a way to 
visualize the physical size of the measured holes in the building, but they are also used in infiltration models 
to estimate the building's natural air change rate (i.e. the air change rate under natural weather conditions).    
 
The Results screen includes one or two leakage area calculations (depending on the selected Test Standard), 
based on differing assumptions about the physical shape of the hole, which are compatible with the two 
most commonly used infiltration models.  
      

� Equivalent Leakage Area (EqLA):  EqLA is defined by Canadian researchers at the 
Canadian National Research Council as the area of a sharp edged orifice (a sharp round hole 
cut in a thin plate) that would leak the same amount of air as the building does at a pressure of 
10 Pascals.  The EqLA is used in the AIM infiltration model (which is used in the HOT2000 
simulation program).  The EqLA is only displayed if the CGSB Test Standard is selected. 

      

� Effective Leakage Area (ELA):  ELA was developed by Lawrence Berkeley Laboratory 
(LBL) and is used in their infiltration model.  The Effective Leakage Area is defined as the 
area of a special nozzle-shaped hole (similar to the inlet of your Blower Door fan) that would 
leak the same amount of air as the building does at a pressure of 4 Pascals.    

      

 

Building Leakage Curve:      
      

� Air Leakage Coefficient (C) and Exponent (n):  Once an automated airtightness test 
sequence (or manual entry of data into the table) has been completed, a "best-fit" line (called 
the Building Leakage Curve) is drawn through the collected Blower Door data.  The Building 
Leakage Curve can be used to estimate the leakage rate of the building at any pressure.  If you 
have conducted a single point test, the program assumes an exponent (n) of 0.65 in its 
calculation procedures.3    

                                                 
3   The assumed exponent value of 0.65 is a typical value for residential construction. 
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The Building Leakage Curve is defined by the variables Coefficient (C) and Exponent (n) in the 
following equation:   

 

  Q = C x Pn     
  where:      
  Q  is airflow into the building.      
  C  is the Coefficient.      
  P  is the baseline adjusted pressure difference between inside and outside the building.      
  n  is the Exponent.           
 
  Example:  Use the Building Leakage Curve to estimate the exhaust fan airflow in a  
  building needed to create a 5 Pa negative pressure.  From our Blower Door test we  
  determined the following Building Leakage Curve variables.       
      
  C = 110.2 (CFM)   n = 0.702    From the equation above:   
 
  Airflow (at 5 Pa) =  110.2 x 5^.702  =  341 CFM.  In other words, we estimate from  
  the Building Leakage Curve that it would take exhaust fans with a combined capacity  
  of 340 CFM to cause a 5 Pa pressure change in this building.        
 

� Correlation Coefficient:  The correlation coefficient is a measure of how well the collected 
Blower Door data fit onto the "best-fit" Building Leakage Curve.  The closer all data points 
are to being exactly on the Building Leakage Curve, the larger the calculated correlation 
coefficient (Note:  the largest possible value for the correlation coefficient is 1.0).  Under most 
operating conditions, the correlation coefficient will be at least 0.99 or higher.      

   
Testing in very windy weather can sometimes cause the correlation coefficient to be less than 
0.99.  In this case, you may want to repeat the test, or increase the number of Samples Per 
Station.  Achieving a correlation coefficient of 0.99 or higher is particularly important in the 
estimation of Leakage Areas, or when using the Building Leakage Curve to estimate leakage 

rates at low building pressures.  Note: The Correlation Coefficient is not displayed when 
conducting a single point test.     

 

 

Estimated Annual Infiltration: 
      
Estimating the natural infiltration rate of a building is an important step in evaluating indoor air quality and 
the possible need for mechanical ventilation.  Blower Doors do not directly measure the natural infiltration 
rates of buildings.  Rather, they measure the building leakage rate at pressures significantly greater than 
those normally generated by natural forces (i.e. wind and stack effect).  Blower Door measurements are 
taken at higher pressures because these measurements are highly repeatable and are less subject to large 
variations due to changes in wind speed and direction.        
      
In essence, a Blower Door test measures the cumulative hole size, or leakage area, in the building's air 

barrier (see Leakage Areas above).  From this measurement of leakage area, estimates of natural 
infiltration rates can be made using mathematical infiltration models.  The TECTITE program uses the 
calculation procedure contained in ASHRAE Standard 136-1993 to estimate the average annual natural 
infiltration rate for purposes of evaluating indoor air quality and the need for mechanical ventilation. 
 

CFM, ACH and CFM/person:  The estimated annual natural infiltration rate (based on ASHRAE 
Standard 136-1993) is expressed in Cubic Feet per Minute (CFM), Air Changes Per Hour (ACH), 
and CFM per person.  When determining occupancy for the CFM/person calculation, the program 
uses the number of bedrooms plus one, or the number of occupants, whichever is greater. 



 

Chapter 9   Viewing Test Results 

TECTITE  
Version 4.0 - WiFi 

45

 

 Notes on Estimated Annual Infiltration Rates: 

 

� Daily and seasonal naturally occurring air change rates will vary dramatically from the 
estimated average annual rate calculated here due to changes in weather conditions (i.e. wind 
and outside temperature).  

 

� The physical location of the holes in the building air barrier compared to the assumptions used 
in the infiltration model will cause actual annual infiltration rates to vary from the estimated 
values.  Research done in the Pacific Northwest on a large sample of houses suggests that 
estimated infiltration rates for an individual house (based on a Blower Door test) may vary by 
as much as a factor of two or more when compared to PFT tracer gas tests.  (PFT tracer gas 
tests are one of the most accurate methods of measuring actual natural infiltration rates.) 

 

� The annual average infiltration estimates from ASHRAE Standard 136-1993 should be used 
only for evaluating detached single-family dwellings, and are not appropriate for use in 
estimating peak pollutant levels or energy loss due to infiltration.  If any of the building 
leakage is located in the forced air distribution system, actual air leakage rates may be much 
greater than the estimates provided here.  Duct leaks result in much greater air leakage 
because they are subjected to much higher pressures than typical building leaks.      

      

 

Estimated Design Infiltration: 

      
In addition to estimating an annual infiltration rate above, the program estimates the design winter  
and summer infiltration rates for the building.  The design infiltration rates are the infiltration rates  
used to calculate winter and summer peak loads for purposes of sizing heating and cooling equipment.  The 
calculated design infiltration rates can be used in ACCA Manual J load calculations in lieu of the estimation 
procedures listed in Manual J.  The estimation procedure uses the design wind speed and temperature 
difference values input into the Climate Information Screen, and are based on the calculation procedures 
listed in the ASHRAE Fundamentals Handbook, Chapter on Infiltration and Ventilation.        
      

Winter and Summer:  CFM, ACH:  The estimated design infiltration rates are expressed in 
Cubic Feet per Minute (CFM), and Air Changes per Hour (ACH).     

      

      

Mechanical Ventilation Guideline: 

      
It is possible, even easy in the case of new construction or when air sealing work is done by trained skilled 
contractors, to increase the airtightness of a house to the point where natural air change rates (from air 
leakage) may not provide adequate ventilation rates to maintain acceptable indoor air quality.  To help 
evaluate the need for mechanical ventilation in buildings, national ventilation guidelines have been 
established by ASHRAE.  The recommended whole building mechanical ventilation rate presented in this 
version of TECTITE is based on ASHRAE Standard 62.2-10, and is only appropriate for low-rise 
residential structures.     
      

Recommended Whole Building Mechanical Ventilation Rate:  This value is the recommended 
whole building ventilation rate to be supplied on a continuous basis using a mechanical ventilation 

system.  It is calculated by adding the Base Rate to the Supplemental Rate (existing houses only), 

and then subtracting the Infiltration Credit (existing houses only). 
 

Base Rate:  The Base Rate is based on 7.5 CFM per person (or number of bedrooms 
plus one, whichever is greater), plus 1 CFM per 100 square feet of floor area.  This 
guideline assumes that in addition to the mechanical ventilation, natural infiltration is 
providing 2 CFM per 100 square feet of floor area.   
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Supplemental Rate:  For existing houses, TECTITE calculates any necessary 
supplemental whole-building ventilation requirements for the house due to ventilation 
deficits in the Kitchen and Bathrooms (based on inputs in the Mechanical Ventilation 
screen). 

 

Infiltration Credit:  For existing houses where the estimated annual natural infiltration 
rate (based on the Blower Door test) is greater than 2 CFM per 100 square feet of floor 
area, the recommended whole building mechanical ventilation rate is reduced to provide 
ventilation credit for excess infiltration.  In these cases, the recommended mechanical 
ventilation rate is reduced by the following amount: 

 
0.5 x (estimated annual natural infiltration rate (CFM) –  0.02 CFM x sq. ft. of floor area ) 

 

Notes on Mechanical Ventilation Guidelines:      
      

� ASHRAE Standard 62.2-10 also contains requirements for local kitchen and bathroom 
mechanical exhaust systems.  These local exhaust systems may be incorporated into a whole 
building ventilation strategy.  Consult Standard 62.2-10 for more information on ventilation 
strategies and specific requirements and exceptions contained in the Standard. 

 

� Compliance with the ventilation guideline does not guarantee that a moisture or indoor air 
quality (IAQ) problem will not develop.  Many factors contribute to indoor air quality 
including ventilation rates, sources and locations of pollutants, and occupant behavior.  
Additional testing (including combustion safety testing) is needed to fully evaluate air quality 
in buildings.  In many cases, a combination of pollutant source control and mechanical 
ventilation will be required in order to ensure adequate indoor air quality.      

      
 

Estimated Cost of Air Leakage: 
      
The program estimates the annual cost associated with air leakage, both for heating and cooling.   
The equations used to calculate the annual cost for air leakage are:       
      

     Annual          26 x HDD x Fuel Price x CFM50          

      Heating  =      --------------------------------------     x  0.6           

 Cost                    N x Seasonal Efficiency      
      
 - HDD is the annual base 65 F heating degree days for the building location.      
 - The Fuel Price is the cost of fuel in dollars per Btu.      
 - N is the Energy Climate Factor from the Climate Information Screen (adjusted for wind  
   shielding and building height).  See Appendix E of the Model 3 Blower Door Operation  
    Manual for more information on this calculation procedure.      
 - Seasonal Efficiency is the AFUE rating of the heating system.      
      
      

      Annual          .026 x CDD x Fuel Price x CFM50      

      Cooling   =     ----------------------------------------      

      Cost                              N x SEER      
      
 - CDD is the base 70 F cooling degree days for the building location.      
 - The Fuel Price is the cost of electricity in dollars per kwh.      
 - N is the Energy Climate Factor from the Climate Screen (adjusted for wind shielding and  
   building height).  See Appendix E of the Model 3 Blower Door Operation Manual for more  
   information on this calculation procedure.    
 - SEER is the SEER rating for the air conditioner.      
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 Note:  Cooling Cost procedure is based on sensible loads only.  In hot humid climates, latent 
 loads due to air leakage can be greater than the sensible loads which are estimated by this 
 procedure. 
 
 

9.2  Deviations from Standards Screen 
 

The Deviations from Standard screen is accessed by clicking on Next from the Test Results screen.  This 
screen lists aspects of the current test data that deviate from the selected Test Standard. 

 
 

Note:   If you are conducting an automated test, and are measuring zone pressures during the Blower Door 
test, the Zone Data screen will appear before the Deviations from Standards screen.  The Zone Pressure 
feature of TECTITE is discussed in more detail in Chapter 10.   
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Chapter 10    Measuring Building Zone Pressures 

 
 
Many important air leaks in a building are not direct leaks to the outside.  Indirect air leaks, or “series 
leaks”, often follow complicated paths through building cavities and through unconditioned zones (such as 
attics, crawlspaces or garages) on their way into or out of the building.  Attic bypasses are a good example 
of a series leak.  Air leaving the house first must flow through the ceiling/attic boundary and then through 
the attic/roof boundary before exiting the house.    
 
Diagnostic procedures have recently been developed to help analyze series leakage paths in buildings. 
These diagnostic procedures, usually called pressure diagnostics, combine standard Blower Door 
airtightness tests with building zone pressure measurements to help prioritize airsealing activities.  The 
TECTITE program can be used to automate the measurement of building zone pressures during a building 
airtightness test.  The zone pressure test results can then be used directly as a performance measurement, or 
as inputs into a separate series leakage analysis program (such as the ZPD Calculation Utility program 
available at no charge from The Energy Conservatory - www.energyconservatory.com). 
 
 

10.1  Using the Zonal Pressure Measurement Feature 

 
In order to make use of TECTITE’s zonal pressure measurement feature, you must select the CGSB Test 
Standard, and TECTITE must be able to establish a communication link with Device(s) containing a total of 
3 or more installed pressure channels. We need at least 3 pressure channels because 2 of the channels (from 

the Primary Device) are already being used to measure the building pressure and Blower Door fan flow.  

For example, if your Primary Device is an APT DAB with 5 installed pressure channels, you would be able 
to use pressure channels P3, P4 and P5 on this Device to measure up to 3 zone pressures by activating P3, 

P4 and P5 in the Zonal Pressures Set-Up screen.  On the other hand, if your Primary Device is a DG-700 

gauge, then you will need to use one or more Aux Devices to utilize the Zonal Pressures feature.  For 
example, if you use one additional Aux DG-700, you would be able to use the two pressure channels from 
this Device to measure up to 2 zone pressures by activating P3 and P4 in the Zonal Pressures Set-Up screen.  

Note:  This feature is currently not available for DG-1000 gauges. 
 

To activate the zonal pressure feature, first click on the Active button in the Zonal Pressures field on the 

Test Settings screen.  Now click on the Settings button to bring up the Zonal Pressures Set-Up screen.  
 

Zonal Pressures Set-Up Screen 
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From this screen you can configure TECTITE to measure zonal pressures during the automated airtightness 
test.  For each installed pressure channel that you want to use, click on the appropriate check box under 
“Activate”.  Edit the corresponding Zone Name field with a descriptive label for the zone being measured.  
Now choose the reference pressure location for that zone in the “With Reference To” field.  When choosing 
the reference pressure location for a zone, we recommend that you choose “outside” if the zone being 
measured is intended to be better connected to the outside (such as in the case of a vented attic, or a garage), 
or choose inside if the zone is intended to be better connected to the inside (such as in the case of most 
basements).  
 
The information that you have entered on the Zonal Pressure Set-Up screen will be stored when you save a 
test file or a configuration file.  You may wish to make zonal pressure set-up part of your default 
configuration file (see Chapter 14 for information on creating and using configuration files).  Once you 

have completed the Zonal Pressure Set-Up screen, click on OK to return to the Test Settings screen.   
 
 

10.2  Taking and Storing Zone Pressure Measurements 
 
Once the Zonal Pressures feature has been activated and the Set-Up screen completed, zone pressure status 
windows will appear at the top of the Test Graph screen (Auto and Semi-Auto Methods).  Active status 
windows will only appear for pressure channels that have been activated in the Set-Up screen and are 
communicating properly with a TEC Device.  For each active status window, the channel and serial number 
of the Device being used to monitor the zone pressure is listed to the left of the window.  If the status 
windows are blank and either of the following two messages appear in the DAB Status Window at the 

bottom of the Test Graph screen (Insufficient Channels for Test, or Aux Device IS NOT 

CONNECTED), refer to Chapter 15 for help on troubleshooting your communication/setup problem. 
 

Zone Pressure Status Windows 

 
 

 
 
Before beginning your airtightness test, you will need to connect tubing to the pressure channels being used 
to measure zone pressures.  The first step is to connect tubing between the zone being monitored and the 
appropriate Input tap on the DG-700 or DAB.  You will also need to connect the Reference pressure tap for 
each zone channel to the reference space that you have designated in the Zonal Pressure Set-Up screen (i.e. 
outside or inside).   For example, if you have set up a channel to measure attic pressure with reference to 
outside, you will need to connect the channel reference tap to tubing running outside.    
 

Note:   If more than 1 channel is being referenced to the outside, you can run a single piece of 
tubing to the outside and use “T” connectors (along with short pieces of tubing) to connect the 
outside tubing to multiple reference pressure taps.   

 
To begin taking zone pressure measurements, you must initiate an airtightness test sequence by clicking on 

the Start Test button.  Zone pressure measurements, including baseline zone pressures, are taken at the 
same time that TECTITE is collecting building pressure and fan flow measurements for the airtightness test.  
For example, if you are conducting a standard CGSB airtightness test procedure at 8 separate target 
building pressures, TECTITE will collect 8 sets of zone pressure measurements, along with a pre-test and 

Attic Crawlspa Garage 
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post-test baseline measurement.  The number of samples taken at each target pressure for the zone pressure 

channels is determined by the Samples Per Station field on the Test Setting screen. 
 

Note:  Zonal pressures displayed in the status windows are adjusted for their current baseline zone 
pressure readings.  During a test sequence, numbers only appear in the zone pressure status 
windows during data sampling.  

 
 

10.3  Viewing Zone Data 

 
Once the automated Blower Door test is completed, the measured zone data are shown on the Zone Data 

screen.  To view the Zone Data screen, click on Next from the Test Graph screen, or choose Zone Data 
from the Goto Menu. 

 

Zone Data Screen 

 
 

10.4  Overview of Zone Data Screen 
 
The left side of the Zone Data screen contains a graph of measured zonal pressure (y-axis) versus house 
pressure (x-axis).  The pressure data points shown on the graph are not adjusted for measured baseline 
zones pressures, and the baseline pressure measurements themselves are included on the graph.  Each data 
point shown on the graph is an average of all samples taken for that zone at a particular target building 
pressure.   Data for an individual zone can be temporarily removed from the graph by clicking on the zone 
name or the check box next to the name.  The graph is automatically re-scaled to accommodate all active 
zone channels.    
 
The columns to the right of the graph provide summary data for each zone.  The summary data can be used 
directly as a performance measurement, or as inputs into a separate series leakage analysis program.   
 

House to Zone @ 50 Pa:   This is the estimated change in house to zone pressure (in Pascals) that would 
occur when the house to outside pressure is changed by 50 Pascals, based on a linear relationship between 
house pressure and zone pressure.    
 

Zone to Outside @ 50 Pa:   This is the estimated change in zone to outside pressure (in Pascals) that 
would occur when the house to outside pressure is changed by 50 Pascals, based on a linear relationship 
between house pressure and zone pressure.    

  

+/- 

Zone  
+/- 

Pressure 
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+/-:   The third numerical column is the estimated repeatability of the House to Zone @ 50 Pa, and the 

Zone to Outside @ 50 Pa estimates.   If you were to repeat this test under the same building setup and 
weather conditions, the new results would not likely differ by more than the estimated repeatability. 
 

Pressure Ratio:   This is the Zone to Outside @ 50 Pa estimate divided by 50.  The Pressure Ratio will 
almost always be a number between 0 and 1.  If the Pressure Ratio is between 0.0 and 0.5, then the zone 
being measured is better connected to outside than inside.  If the Pressure Ratio is between 0.5 and 1.0, then 
the zone being measured is better connected to inside than outside.  As a simple memory aid:  remember 
that “0 = Outside” and “1 = Inside”. 
 

Example Pressure Ratios 

+/-:   The fifth numerical column is the estimated repeatability of the Pressure Ratio.   If you were to 

repeat this test under the same building setup and weather conditions, the new Pressure Ratio would not 
likely differ by more than the estimated repeatability. 
 

Note:   If you have set up the pressure hoses to your DAB correctly, the House to Zone @ 50 and 

Zone to Outside at 50 estimates will almost always appear as positive numbers, whether you are 
depressurizing or pressurizing the building.  If these estimates appear as negative numbers, you 
have probably connected the hoses incorrectly, or have designated the wrong reference location in 
the Zone Pressure Set-Up Screen.   

 
 

10.5  ZPD Input Table 
 
If you are using The Energy Conservatory’s ZPD Calculation Utility program to estimate air leakage rates 
from zones monitored during an automated Blower Door test, the ZPD Input Table contains all of the test 
data required to be input into the calculation utility program.  The ZPD Input Table can be found at the end 

of the Zone Data Report which is available from the main File menu (see Chapter 12  Printing Test 

Reports for more information).  The ZPD Input Table is not displayed on the Zone Data Screen. 
 
 
 
 
 

 

 

House to Zone @ 50 Pa Zone to Outside @ 50 Pa Pressure Ratio 

50 0      0.00 (zone is outside) 

49 1      0.02 

45 5      0.10 

40 10      0.20 

30 20      0.40 

25 25      0.50 

20 30      0.60 

10 40      0.80 

5 45      0.90 

1 49      0.98 

0 50      1.00 (zone is inside) 
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Chapter 11     Saving and Retrieving Building Test Files 

 
 

11.1  Saving Building Test Files 

 

Test files can be saved at any time by selecting File from the Main TECTITE Menu, and then clicking on  

Save Current Test File which appears in the File Menu. 

 
Saved building test files contain all information entered into the Building Test Information, Environmental 
Information, Mechanical Ventilation, Comments and Test Setting screens, as well as all test data shown on 
the Graph.  When saving a test file, you will need to enter a file name in the file save window that appears 
on screen.  You may also choose a different destination folder for the saved file by using the folder options 

appearing in the file save window.  All building test files are automatically given a .bld extension.   
 

Note:  If you want to create a PDF file of the building test reports, refer to Chapter 12 Printing 
Test Reports.  The PDF format is a “printed page” viewable file that will display identically on all 
computers.  

 
 

11.2  Retrieving Building Test Files 

 

To retrieve a previously saved building test file for viewing, editing or printing, first select File from the 

Main TECTITE Menu, and then click on Retrieve Existing Test which appears in the File Menu. 

 

After selecting the Retrieve Existing Test option, a file select window will appear on screen which lists all 
the building (.bld) files contained in the current default folder.  To select a file, click on the file name from 

the list and then click on Open.  Once the file has been selected, the file information is loaded into the 
TECTITE program and the Building Test Info screen appears.  To change the folder being listed, use the 
folder options appearing in the file select window.   
 
 

11.3  Retrieving a Saved Test as the Starting Point for a New Test 
 
If you want to perform a repeat test at a building that you have previously tested, it is very convenient to 

start by retrieving the old test.  Choose Retrieve Existing Test from the File menu and select the old 
building test file.  As you go through the data entry screens, check for any information that has changed 
since the old test was performed. 
 

Importantly, when you get to the Test Graph screen click on the Clear Data button.  This clears the data on 

the Graph so that you can perform a new airtightness test.  Use of the Clear Data button will not affect the 
original building test file stored on your computer.  When you are done, save your new test using a new file 
name. 

 

Manual Method Users: 
 

When using the Manual data entry method, the data on the graph can be cleared by clicking on the Clear 

Data button from the Data Table window.
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Chapter 12      Printing Test Reports  

 
 

12.1  Printing and Preview Options 

 

Report printing and previewing options are available by clicking on File in the Main Menu.   

 
The TECTITE program allows you to print, preview or create a PDF file for a set of pre-formatted reports 
including a Customer Report, Detailed Report, Test Graph, and Zone Data Report.   

 

Note: The report format is dependent on the Test Standard selected in the Test Settings screen.  In 
addition, the actual length of the Test Report and Zone Data Reports depend on the number of data 
points collected during the test.  

 
The Customer Report contains the basic building airtightness test results and a simplified description of 
how to interpret the test results.  Detailed Reports contain a complete listing of the building airtightness data 
and results, as well as any comments input into the Comment Screen.  The Zone Data Report contains a 
listing of all measured zone pressures and estimated building to zone and zone to outside pressures at 50 
Pascals of building pressure, as well as a graph of zone pressures versus building pressures. In addition, the 
end of the Zone Data Report includes a ZPD Input Table which contains test data which can be directly 
input into The Energy Conservatory’s ZPD Calculation Utility program used to estimate the leakage rate of 

monitored zones. Note: The Zone Data Report is only available if the building test file currently loaded into 
TECTITE contains zone pressure data. 
 
The Test Graph is similar to the graph of fan flow (or leakage) vs. building pressure from the Test Graph 
screen.  It can be used to visually estimate the relationship between air leakage and building pressure. 
 
The printing and preview functions within TECTITE utilize the printer drivers and configuration options 
currently installed in your computer.  
 

 Creating a PDF File of the Test Reports: 

 

TECTITE makes it easy to create a PDF file of any of the reports.  Simply choose the Print Report to PDF 

File option, and then enter the name and location of the file to be saved in the file save window that 
appears.  Once created, these files can be viewed on any computer that has PDF viewing software installed.  
 
 

12.2  Putting Your Business Name and Logo on the Reports 

 
The name, address and contact information for your business can be placed at the top of the first page of all 
printed reports by completing the Business Info window.  To access the Business Info window, click on 

Options in the Main Menu, and then click on Business Info from the Options Menu.  Information entered 
in the Business Info window is saved as part of the data files. 
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Business Information Window 

 
 

Adding Your Logo to the Top of Printed Reports:   

 

To insert a logo at the top of the printed reports, simply click on the Load New Logo button.  In the Select 
Logo File window which appears, find and select the desired image file from your computer.  TECTITE  
allows you to choose the following file types for a logo image: bmp, jpg, tif and emf.   
 
TECTITE makes a copy of the selected file and places the copy in the appropriate program directory on 
your computer.  The selected logo image is automatically placed in the upper left hand corner of the printed 
reports.  The image is placed in a 2.25 inch wide by 1.375 inch high box, and the program sizes the image 
(using its saved aspect ratio) to maximize its size within the box.  Logo images which have a 2.25 to 1.375 
width to height ratio will completely fill the image box.  Images with any other aspect ratio will only 
completely fill the image box in one dimension.  
 

To delete the stored logo image file, click on the Delete Logo button.  
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Chapter 13      Cruise Control  
 
 
The Cruise Control feature automatically adjusts the speed of the Blower Door fan to maintain a constant 
building pressure while the operator or technician performs additional diagnostic or air-sealing procedures.   
While cruising, the program displays the current building pressure and fan flow, and displays current zone 
pressures if the zonal pressures feature is active.  However, TECTITE does not store fan flow, building 
pressure or zone pressure data while cruising.  Common applications of the Cruise Control feature include: 
 

� Pressure pan testing for evaluating leakage in forced air duct systems. 

� Maintaining a constant building pressure while locating and sealing air leaks. 

� Quickly estimating the building leakage rate before conducting a full airtightness test. 

� Series leakage tests such as the Leakage Area Matching Method, or Add-a-Hole method to 
quantify leakage rates between various zones within a building. 

 

Note:  The Cruise Control feature can only be used if your Blower Door fan speed control has a 
communication jack on the side of the controller, and you have installed the fan control cable between the 
controller and your TEC Device. 
 
 

13.1  Starting the Cruise Control Feature 
 
Before using the Cruise Control feature, be sure that the building and fan pressure tubing is properly 
connected to the TEC Device.  
 
 

• Ch A/P1 Input Tap:  Connect to inside of building (leave open if gauge is in building). 

• Ch A/P1 Reference Tap:  Connect to outside. 

• Ch B/P2 Input Tap:  Connect to Blower Door fan. 

• Ch BP2 Reference Tap:  Connect to space upstream of fan inlet (if gauge and fan inlet are in the 
same space, leave open). 
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Cruise Control is activated from the Test Graph screen and can only begin if a communication link has been 
established between your computer and the TEC Device.  If a communication link has been established, the 

message Idle - Monitoring appears in the green DAB Status Window and the Start and Cruise buttons are 
available.  For more information on establishing a communication link between your computer and your 
TEC Device, see Chapter 15. 
 

To activate the Cruise Control feature, click on the Cruise button from the Test Graph screen.  Now fill in 

the Cruise Pressure field and select a Baseline option in the Cruise Test Conditions window which appears 
on screen. 
 

Cruise Test Conditions Window 

 

 

 

Cruise Pressure:   

 
Enter the building pressure (in Pa) that you would like the Blower Door fan to maintain.  Always enter the 
cruise pressure as a positive number, even if you are depressurizing the building.  For example, if the test 
mode is set to depressurize, and you wish to cruise at a building pressure of -50 Pa, enter the cruise pressure 
as 50.  The TECTITE program will now adjust the speed of the Blower Door fan until the cruise pressure is 
achieved, and will continuously adjust the fan speed to maintain the cruise pressure. 
 
 

Baseline: 

 

� No Baseline:    This option is used when you want to cruise without first measuring and 
adjusting for the baseline building pressure.  In other words, you will not adjust the displayed 
building pressure by the measured baseline pressure.  If you are displaying zone pressures 
while cruising, they will not be adjusted for the baseline zone pressure. 

 

� Cruise With Baseline:   This option is used when you want to adjust the displayed building 
pressure by the measured baseline building pressure.  Use this feature when you want to 
change the building pressure by the specified cruise pressure.  For most users, this is the 
preferred cruising method.  If you are displaying zone pressures while cruising, they will be 
adjusted for the measured baseline zone pressures. 

 

After clicking on OK in the Cruise Test Conditions window, you will be asked to indicate which flow ring 

will be installed on the fan during cruising.  Click on the appropriate ring and then click on Proceed with 

Cruise.  This allows the program to display the fan airflow, as well as the building and zone pressures  
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while cruising.  Current fan airflow and building pressure are displayed in the Status Windows on the right  

side of the Test Graph screen, and by the moving cursor on the graph.4   The entered cruise pressure is 
displayed on the graph by a red vertical line.   
 
 

13.2  Ending Cruise/Stopping the Fan 
 
Once Cruise Control has been activated, there are two ways to turn off the cruise feature:  
 

� Click on Pause or press the Esc key.  This immediately stops the fan, and the operator is 

allowed to either adjust the Auto Test Settings, re-start cruising or terminate the cruise 
procedure. 

� Click on Stop Cruise.  This immediately stops the fan and ends the cruise procedure. 
 
 

13.3  Real-Time ACH50 Estimator 

 
When the Cruise Control feature is active, TECTITE will display a real-time estimate of Air Changes per 
Hour at 50 Pascals of building pressure (ACH50) on the Test Graph screen.  To estimate ACH50, 
TECTITE uses the current measured fan flow, the volume estimate input into the Building Test Info screen, 
and an assumed Building Leakage Curve exponent (n value) of 0.65.  The ACH50 display window is only 
active when the current building pressure is between 40 and 60 Pascals, and a valid fan flow measurement is 
being made.  The on-screen ACH50 display is useful for quickly estimating building leakage rates before 
conducting a full airtightness test.  
 

Real-Time ACH50 Estimator 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note:  The Real-Time ACH50 display is also active when TECTITE is in the Idle – Monitoring mode and 
the user is manually adjusting the fan speed (and the current building pressure is between 40 and 60 Pa). 
The Real-Time ACH50 display is not active during an automated test sequence. 
 

                                                 
4   If you activate the Cruise option while Blower Door data are being displayed on the graph, the data will remain on 
the graph and will not be affected or changed in any way.  

  Ring  A

ACH50 Estimator Window 
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13.4  Using the Display Large Meters Feature 

 
The Display Large Meters feature replaces the graph on the Test Graph (Auto Method) screen with 3 large 
status windows including Real-Time ACH50, Current Fan Flow, and Current Building Pressure.  The 

feature can be toggled on and off by clicking on Display Large Meters from the Options Menu. 
 
 
 
 
 
 
 
 
The Display Large Meters feature is particularly useful when looking at the computer screen from a distance 
while cruising or manually adjusting the Blower Door fan in Idle-Monitoring mode.  The Real-Time 
ACH50 display window is only active when the current building pressure is between 40 and 60 Pascals, and 
a valid fan flow measurement is being made.  The Real-Time ACH50 display is not active during an 
automated test sequence. 
 

Large Meter Display 

 
 
 
 
 

  Ring  A
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Chapter 14      Creating and Using Configuration Files  

 
 

14.1  What is a Configuration File? 
 
There is a significant amount of data entry required in filling out all of the screens of TECTITE.  A 
configuration file is a place to save test settings, building and customer information, and comments that you 
routinely use so they can be quickly loaded into the program.  The configuration file can then be used as a 
shortcut for speeding up data entry for future tests.  A configuration file looks just like a building test file, 

except that no test data (i.e. building pressure or fan airflow readings) are stored in configuration files.5 
 
 

14.2  How to Create a Configuration File 
 
Before creating a configuration file, first be sure to save any current test data loaded into TECTITE by 

using the Save Current Test File option from the File Menu.   
 

Now select the New Test option from the File Menu.  Proceed through the Input and Test Settings screens, 
filling in only the information which will be always be the same for your testing.  If there are any “standard” 
comments which you would like to have on all tests, type them in on the Comments screen at this time.  On 
the Test Settings screen, choose the settings you wish to save.   Finally, open the Business Info and 
Equipment Info windows (found in the Options Menu) and complete the appropriate fields.  
 

When you have finished entering information and settings that you wish to save, select Save Configuration 

File from the File Menu. 
 

 
When saving a configuration file, you will need to enter a file name and file location in the file saving 

browser that appears on screen.  All configuration files are automatically given a .cfa extension.   
 
 

14.3  How to Use Configuration Files 

 

To use a configuration file when conducting a new test, click on New Test with Custom Configuration 
from the File Menu. 

 
After selecting the “Custom Configuration” option, a file browser will appear on screen.  Select a .cfa file  

from the list (or browse to the file location) and then click Open.  Once the configuration file has been 
opened, the file information is loaded into the TECTITE program and the Building Test Info screen 
appears.   

                                                 
5  Information entered using the Options Menu (e.g.  Business Info and Equipment Info screens) are also stored when a 
configuration file is created. 
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After loading the selected configuration file, complete the remaining data entry fields and proceed with the 
test.  Importantly, you are not “locked into” the entries which were loaded from your configuration file.  
You can always edit all data entry fields during the test. 
 
Some users may wish to create custom configuration files for a variety of testing situations they frequently 
encounter.  For example, a user may have separate configuration files for each city where they frequently 
test.  Configurations can also be created which are specific to: 
 
 test location 

test standard 
 house type 
 fan model and serial number 
 testing protocol (e.g. custom pressure lists) 
 calm versus windy conditions 
 
Keep in mind that the Comments screen can be a particularly useful part of custom configuration files by 
containing “boiler plate” comments which you would like to print out (or edit) for all tests. 
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Chapter 15     Troubleshooting TECTITE  

 
 

15.1  Basic Tips 
 

• If there is an on-screen warning message, refer to the list of Operator Messages in Chapter 7. 

• If you are having trouble completing an automated Blower Door test or Cruise procedure, first check 
that the Blower Door and DG-700, DG-1000 or DAB system are set up as shown in Chapter 2.   

 
Refer to example problems below for information on more specific operating problems. 
 

Problem 1:   When trying to start an automated test or cruise procedure from the Test Graph screen,    

the Start and Cruise buttons are grayed out and the DAB Status Box is displaying the 

message:   “Primary Device IS NOT CONNECTED”.  

 
The Primary Device is the DG-700, DG-1000 or APT DAB that will be used to measure building pressure 
and fan flow during the Blower Door test.  When the Method field (in the Test Settings screen) is set to 

Auto or Semi-Auto, and you are viewing the Test Graph, TECTITE will attempt to establish a 

communication link with a Primary Device using the method specified in the Device Connection window.  

Failure to establish a communication link will result in the Primary Device IS NOT CONNECTED 
message appearing. 

 

There are two options for specifying a Primary Device in the Device Connection window: 
 

� Checking the AUTO SELECT button in the Device Connection window will allow TECTITE to 
automatically search for TEC devices on all available communication ports and wireless networks on 

your computer.  AUTO SELECT is the preferred option to establish communication with your TEC 

Device.  AUTO SELECT will attempt to establish a communication link with the first Energy 
Conservatory Device that it finds.  If a communication link is established, this device is considered the 
Primary Device.  

 

� If you uncheck AUTO SELECT, you may specify a specific Primary COM Port (COM 1 through 

COM 256) to connect with a DG-700 gauge or with an APT DAB.  Note: This option does not work 
with a DG-1000 gauge. 

 

The easiest way to quickly check your computer for all currently connected Energy Conservatory Devices is 

to use the Scan for Devices button in the Device Connection window.  Once the Scan window is open, 

clicking on Start Scan will provide a list of all Energy Conservatory Devices that TECTITE can currently 
locate and establish a communication link with.  The list includes devices connected through all wired 

communication ports, and through the computer’s wireless network adapter.  Note:  The Energy 
Conservatory Device must be ON to be detected. 
 

Other items to check if you are having communication problems:   

 
� If you are using a wired connection, make sure that you have properly installed the communication 

cable between your computer and the Energy Conservatory Device. 
� If you are using a DG-1000 or TEC WiFi Link to wirelessly communicate between your computer and 

the gauge, follow the instructions that came with the gauge or WiFi Link.  Lost communication could 
be caused by a weak wireless signal, interference on the wireless network, or incompatibility of the 
laptop internal wireless network adapter.  Try moving the laptop closer to the gauge, or changing the 
AP broadcast channel if you are using wireless Access Point (AP) create network mode. 
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� Check that the Energy Conservatory Device has been turned ON and has power. 
� Make sure you are not running 2 copies of TECTITE at the same time. 
 

Once the proper communication link has been established, the message Idle Monitoring appears in a green 
DAB Status Window at the bottom of the Test Graph screen.  
 
 

Problem 2:  During an automated  test, the program never starts taking data at a target pressure line,   

       even though the Airflow and Building Pressure Cursor appears to be bouncing around the 

        target pressure.  After a few minutes the message  “Warning excessive building pressure  

     fluctuation for the current target pressure..” appears. 

 
In order for the TECTITE program to start taking data at any target pressure line, it must first determine that 
the current measured building pressure is within a specified range from the target building pressure. This 

specified range is called the Target Tolerance.  If the current measured building pressure is fluctuating 

beyond the Target Tolerance, then data collection for that target pressure will not begin.  Fluctuating 
building pressure readings can be caused by improper installation of the building pressure reference tubing, 
or by windy weather. 
 

� First check to be sure that the outside end of the building pressure tubing (e.g.  the green tubing 
connected to the Channel A/P1 Reference tap) is not placed directly in the exhaust airflow of the 
Blower Door fan.  You must be careful to run the end of the tubing well away (at least 5 feet to the 
side) from the exhaust of the fan.  A good location for the end of the building pressure tubing is at the 
base of the building where it meets the ground.   

 

Note:  Although it is common practice for Blower Door operators to insert the open end of the 
building pressure tubing a few inches through the patch on the nylon panel, and leave it, we have 
determined that this set up practice can create inaccurate building pressure readings due to the 
exhaust airflow from the fan hitting the end of the tubing. You should always follow the tubing set-
up practice listed above to prevent fluctuating building pressures.   

 

� If the building pressure tubing is installed correctly, the fluctuating building pressures are probably 
caused by wind.  Try increasing your Target Tolerance to 3 or 4 from the default value of 2 (the Target 
Tolerance can be changed by clicking on the Adjust Auto Test Settings button in the warning screen).  

If this doesn’t work, increase the Target Tolerance to 5 or greater, or use the Sample button (see 
below).   

 
� During an automated test, you can manually instruct the computer to go ahead and take data by clicking 

on the Sample button.  At this point, the computer will proceed just as if it has decided that the Target 
Tolerance for the current pressure station line had been met. 

 

Note:  As the Target Tolerance is increased from the default value of 2, gathered data may not be 
as close to the target pressure lines as would be the case when using the default value.  This has 
negligible effect on the final test results.  However, some test standards do require that the 
measured building pressures be within a specified range of the target pressure (e.g. the CGSB test 
standard requires that the measured building pressures be within +/- 2.5 Pa of the specified target 
pressure). 

 
 

Problem 3:   When trying to start an automated test or cruise procedure from the Test Graph screen,    

the Start and Cruise buttons are grayed out and the DAB Status Box is displaying the 

message:  “Aux X Device IS NOT CONNECTED”.  

 

Aux Device(s) are additional DG-700s or APT DABs that can be used exclusively to measure zonal 
pressures during the Blower Door test using the Zonal Pressures feature.  If a communication link has been  
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established with the Primary Device, and the Zonal Pressures feature has been turned on (Test Settings 

screen), TECTITE first checks to see if the Primary Device has sufficient pressure channels to measure the 

active zone pressure channels.  For example, if your Primary Device is an APT DAB with 6 installed 

pressure channels, you would be able to measure up to 4 zone pressures without needing an Aux Device 

(the first two channels on the Primary Device are always used to measure building pressure and Blower 

Door fan flow).  On the other hand, if your Primary Device is a DG-700 gauge, then you will need to use 
two Aux DG-700’s to measure 4 zone pressures.   
 

If the Primary Device does not have sufficient channels, then TECTITE tries to establish a communication 

link with an Energy Conservatory Device using the specified Aux 1 COM Port.  If a communication link 

can not be established through the Aux 1 COM Port, then the message “Aux 1 Device IS NOT 

CONNECTED” appears.  If a communication link is established through the Aux 1 COM Port but there 
are still insufficient pressure channels available for the active zone pressures measurements, then TECTITE 

repeats the same process for the designated Aux 2 and Aux 3 COM Ports.  Note:  When specifying Aux 

COM Ports, always use the Aux COM Ports in order from Aux 1 to Aux 3.  
 

AUTO SELECT must be unchecked in order to specify Aux COM Ports.  If you will not be using the 

Zonal Pressures feature, leave all three Aux COM Ports set to None and uncheck the Active button in the 

Zonal Pressure feature field in the Test Setting screen.  Note: DG-1000 gauges cannot be used as Aux 

Devices with this version of TECTITE.  
 
 

Problem 4:   When trying to start an automated test or cruise procedure from the Test Graph screen,    

the Start and Cruise buttons are grayed out and the DAB Status Box is displaying the 

message:   “Insufficient channels for test.”  

 
The “Insufficient channels for test” message appears under the following circumstances: 
 

A communication link has been established with the Primary Device and any designated Aux Devices, and  
 
� The Zonal Pressures feature has been activated (Test Setting screen), and 
� There are insufficient pressure channels available for the active zone pressure measurements.  
 

You will either need to specify additional Aux COM Ports and Devices, or reduce the number of active 
zone pressure measurement channels, or turn off the Zonal Pressures feature. 
 
 

Problem 5:   When trying to start an automated test or cruise procedure from the Test Graph screen,    

the Start and Cruise buttons are grayed out and the DAB Status Box is displaying the 

message:   “OFF LINE:  Communication with devices disabled.”.  

 

The OFF LINE feature is used to prevent TECTITE from communicating with Primary or Aux Devices 

when viewing the Test Graph screen.  This feature increases the responsiveness of TECTITE when viewing 
previously stored data files.  In order to conduct automated Blower Door tests, you will need to uncheck the 
OFF LINE feature box in the Device Connection window.   
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Chapter 16      Entering Custom Fan Calibration Parameters 

 
 
The TECTITE program comes installed with factory default fan calibration parameters for the Model 3 and 
Model 4 Minneapolis Blower Door and Series A and B Duct Blaster fans.  The fan calibration parameters 
are used by the program to convert the measured fan pressure in Pascals to airflow in Cubic Feet per 
Minute. 
 
If your Blower Door fan was custom calibrated by The Energy Conservatory, you can input your custom 
calibration parameters directly into the TECTITE program in lieu of the factory default values.  To enter 

custom fan calibration parameters open the Equipment Info window by clicking on Options....Equipment 

Info from the Main TECTITE Menu. 

 
 

Equipment Information Window (Auto and Semi-Auto Methods) 

 
From the Equipment Info window, be sure you have selected the appropriate fan model from the pull down 

menu, and then input the fan serial number.  Now click on the Enter Custom Fan Calibration button to 
open the Fan Calibration Parameter window. 
 

Note:  If you are conducting an Automated or Semi-Automated test, the TECTITE software will 
automatically store the micromonometer serial number and calibration information as part of the 
building test file.  If you are conducting a Manual test, the Equipment Info window will include 
fields where you can input and store a micromonometer serial number and calibration date (see 

Equipment Information Window (Manual Method below).   
 

Note 2:  If you If you change the selected fan model while test data are being displayed on the 
graph, the test data will automatically be cleared. 
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Fan Calibration Parameters Window 

 
The Fan Calibration Parameter window shows the calibration parameters being used by the program for the 
currently selected fan model and selected airflow units.  There is a unique set of parameters for each of the 
flow ring configurations used with the fan.  The individual calibration parameters can be edited by using the 

Tab key, or by clicking on the input fields.  Whenever you input a custom calibration parameter, the new 
value shown in the field will be displayed in red, rather than black for the default values.  You can easily 

return all calibration parameters to the factory default values by clicking on Set to Defaults.  The currently 
entered fan calibration parameters are stored as part of the data file. 
 

Note:  Most users should never have to edit fan calibration parameters.  The default fan calibration 
parameters which come with TECTITE are valid for all standard Minneapolis Blower Door and Duct 
Blaster fans.  This feature is necessary only if you receive custom calibration parameters for your fan from 
The Energy Conservatory. 

 
 

Equipment Information Window (Manual Method) 
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Chapter 17      Using the Compare Tests Feature  

 
 
The Compare Tests features allows you to select two previously saved building test files and to quickly 

compare the stored test results.  To use this feature, select File from the Main TECTITE Menu, and then 

click on Compare Tests which appears in the File Menu. 
 

 
 
 
 
 

 
 

17.1  Choosing the Test Files to Compare 
 

After selecting the Compare Tests option, a file browser titled “Select Building Test File #1 to Compare” 
will appear on screen which lists all the building (.bld) files contained in the default folder.  Select the first 

file by clicking on a file name from the list and then click on Open.  Once the first file has been selected, a 
second file browser titled “Select Building Test File #2 to Compare” will appear.  Select the second file and 

once again click on Open.   
 
After both files have been selected, a comparison of the test results from the two files will be displayed on 
the screen.  Both the numeric change and percent change between the two tests are displayed for each of the 
test result items.  If a test result item is missing from one or both of the building files, then comparison 
results for that item will not be displayed.  If zone data were collected for either building file, it can be 

viewed by clicking on the Zone Data button.  A graph comparing the building leakage curves for both 

selected building files can be viewed by clicking on the Test Graph button.  
 

To exit the Compare Tests feature, simply select a different option from the top of the FILE menu, or exit 
the TECTITE program. 
 
 

17.2  Printing and Preview Options 

 

Printing and previewing options for the Compare Tests feature are available by clicking on File in the Main 
Menu.  The Comparison Report contains the same information that is displayed on the Compare Test 
Results screen, plus any zone data that were collected for either building file. The Comparison Graph 
displays the building leakage curve for both selected test files.  The printing and preview functions within 
TECTITE utilize the printer drivers and configuration options currently installed in your computer.   
 
 
 
 


